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Ch­¬ng I: 

Mét sè thao t¸c c¬ b¶n trong Windows

* Giíi thiÖu chung
Word 2003 lµ phÇn mÒm so¹n th¶o v¨n b¶n v¨n b¶n cao cÊp ch¹y trong m«i tr­êng Windows, chuyªn dïng ®Ó so¹n th¶o c¸c v¨n b¶n, s¸ch vë t¹p chÝ, viÕt b¸o… tãm l¹i Word ®Ó phôc vô cho c«ng t¸c v¨n phßng.

Bµi 1: Khëi ®éng vµ t¾t m¸y vi tÝnh
1) BËt m¸y vi tÝnh

- BËt c«ng t¾c mµn h×nh (Power)

- BËt c«ng t¾c ë CPU - Central Processing Unit (Power - Bé xö lý trung t©m).

2) T¾t m¸y vi tÝnh

C1: BÊm chuét vµo --> Start --> Turn off Computer…(XuÊt hiÖn hép tho¹i nh­ h×nh vÏ)
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                                                                    Råi b¹n nh¸y vµo --> Turn off

                                                                                nh­ h×nh d­íi ®©y


C2: Tõ bµn phÝm b¹n nhÊn ®ång thêi hai phÝm Alt + F4 --> Turn off
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 -->Turn off Computer… --> Turn off
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Bµi 2:
B¾t ®Çu víi MICROSOFT WORD

1. Khởi động Word 2003: 

[image: image91.wmf]Cách 1: Nhấn nút Start --> Programs --> Microsoft Office --> Microsoft Office Word 2003. 
[image: image92.wmf]VietKey 2000.lnk

Hình 1: Khởi động chương trình word

Cách 2: Nhấn chuột vào biểu tượng Microsoft Office Word 2003 trên màn hình nền.

2. Cách thoát khỏi Word cũng như các chương trình khác:  


C1 --> Click vµo biÓu t­îng ch÷ X cã mµu ®á ë gãc ph¶i mµn h×nh





[image: image3.png]help [+



trên góc phải màn hình. 

*Lưu ý: Khi thoát khỏi Word. Có thể Word sẽ nhắc ta ghi lại tập tin nếu tập tin ta chưa đặt tên hoặc ta mở một tập tin đã có ra sửa chữa. 
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* Có 3 lựa chọn như sau : 
Yes - Có ghi lại những thay đổi của tập tin; 

No - Không ghi lại; 

Cancel-Bỏ qua quay lại tiếp tục soạn thảo.

C2: -->  NhÊn tæ hîp phÝm Alt + F4

C3: --> File --> Close (Exit)

C4: --> C¸ch tho¸t khái mét sè trß ch¬i còng nh­ mét sè ch­¬ng tr×nh do b¹n bÊm nhÇm vµo nh­ sau: (b¹n nhÊn phÝm ESC - escape hoÆc chän c¸c c¸ch 1 or  2  or  3 nh­ trªn  or chän Close  or  Exit  or  quit).
3. L­u ý:
- Khi ch¹y mét ch­¬ng tr×nh nÕu muèn ®æi ch­¬ng tr×nh kh¸c th× b¹n cÇn ph¶i ®ãng ch­¬ng tr×nh cò l¹i ch¸nh ch¹y nhiÒu ch­¬ng tr×nh m¸y sÏ kh«ng ®ñ bé nhí ®Ó ho¹t ®éng nªn bÞ cheo.

- Khi ®Ìn ë CPU hoÆc mét æ ®Üa nµo ®ã ®ang s¸ng hoÆc chuét cã biÓu t­îng ®ång hå c¸t th× b¹n kh«ng ®­îc bËt, t¾t m¸y v× lóc nµy ®Çu tõ ®ang ®äc hoÆc ®ang ghi lªn ®Üa.

- Tr¸nh bËt t¾t m¸y vi tÝnh nhiÒu: V× lóc nµy m¸y rÊt hay bÞ háng.

4. Giới thiệu màn hình chính 
+ Thanh Menu (Thực đơn): chứa các menu tập hợp lệnh như File, Edit ...
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Hình 2: Màn hình chính của chương trình soạn thảo văn bản Word
+ Thanh Standard (Thanh công cụ chuẩn): chứa các công cụ như: mở tệp tin (Open), in ấn (Print), sao chép (Copy) ....
+ Thanh Formatting (Thanh định dạng): chứa các công cụ định dạng văn bản: phông chữ, in đậm, nghiêng .....
+ Thanh Tables and borders  (Thanh bảng và đường viền): 
+ Thanh Drawing (Vẽ): chứa các công cụ vẽ: vẽ đoạn thẳng (line), mũi tên (Arrow), vẽ hình oval, các văn bản nghệ thuật WordArt ....
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5. Chế độ nhìn.

Thay đổi chế độ nhìn để xem bố cục hoặc chi tiết văn bản; Ở chế độ phóng to hay thu nhỏ không ảnh hưởng tới văn bản khi in ra.
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Hình 4: Phóng to thu nhỏ màn hình
xxxxxxxxxxxxxxxxxxxxxa

+ Để thay đổi chế độ nhìn phóng to, thu nhỏ văn bản ta nhấn mũi tên xổ xuống, chọn phần trăm thích hợp (hoặc gõ số phần trăm và nhấn Enter) trong hộp Zoom trên thanh công cụ..

+ Chuyển qua lại giữa các kiểu nhìn trong Menu View trên thanh công cụ hoặc nhấn biểu tượng các chế độ nhìn phía dưới, bên trái của màn hình.
6) ChÕ ®é gâ chÌn ®Ì:

PhÝm Insert dïng ®Ó bËt, t¾t chÕ ®é gâ chÌn, ®Ì (NÕu bËt ë chÕ ®é gâ ®Ì th× mµn h×nh sÏ hiÖn ch÷ 0VR ë phÝa d­íi).
Bµi 3: So¹n Th¶o v¨n b¶n trong Word

1) C¸ch gâ tiÕng viÖt trong Word  (Gâ kiÓu Telex - TCVN - ABC)  

Có rất nhiều kiểu gõ tiếng Việt, kiểu gõ thông dụng nhất ở Miền Nam là kiểu gõ VNI kiểu gõ này dùng các phím số để gõ dấu; ở Miền Bắc thường dùng kiểu gõ TELEX theo bảng mã Tiêu chuẩn Việt Nam 
	B¹n gâ
	§­îc
	
	B¹n gâ
	§­îc

	aa
	©
	
	f
	huyÒn

	oo
	«
	
	s
	s¾c

	ee
	ª
	
	r
	hái

	dd
	®
	
	x
	ng· 

	aw
	¨
	
	j
	nÆng

	uw, ], w
	­
	
	z
	xo¸ dÊu

	ow, [
	¬
	
	
	

	ooo
	oo
	
	
	


*)  Lưu ý: 

- Cặp chữ ƯƠ rất hay gặp trong tiếng Việt, để gõ nhanh có thể dùng 2 phím ][ gần nhau để đạt được tốc độ cao do giảm một nửa số thao tác do phải gõ các phím cách xa nhau UWOW.

- Trong trường hợp gõ sai dấu ta có thể gõ lại dấu đúng ngay sau nguyên âm, chương trình sẽ tự động sửa lại dấu không phải xoá chữ để gõ lại, nếu muốn bỏ dấu thì ta chỉ việc gõ chữ Z.

- Muốn gõ các chữ: W, J, S, R, X, F ta gõ phím đó 2 lần liên tiếp.

Ví dụ: muốn gõ chữ W ta gõ WW.

- Muốn gõ hai chữ O ta gõ phím O ba lần liên tiếp.

Ví dụ: Xoong nồi ; ta gõ Xooong nooif
2. Chức năng chủ yếu của 1 số phím dùng để soạn thảo.

a.  Phím Shift: Dùng để viết hoa một hoặc vài chữ cái khi giữ phím Shift  cùng với chữ cái cần viết hoa;
+ Ên vµ gi÷ phÝm Shift (Cïng víi ch÷ c¸i cïng cÇn viÕt hoa)

.  Đối với các phím mà có hai kí tự đại diện muốn đánh kí tự phía trên ta phải bấm phím Shift  cùng với kí tự . Ví dụ: muốn gõ ký tự % ta phải nhấn phím Shift và gõ phím số 5.

b.  Phím Caps Loock: Chuyển bàn phím sang đánh chữ in hoa khi đang gõ chữ thường và ngược lại. 

+ Ên phÝm Claps Lock (Sau ®ã Ên ch÷ cÇn viÕt hoa)
---> L­u ý: khi muèn viÕt hoa c¶ dßng ch÷ ta ph¶i chän kiÓu (Font ch÷) chø kh«ng dïng hai c¸ch trªn.
+ Phím Tab: mỗi lần nhấn sẽ thụt đầu dòng vào một khoảng dừng Tab. Mặc định là 1,25cm.

+ Phím Space Bar (phím cách): Dùng để đẩy ký tự sang bên phải hoặc chèn  khoảng trắng giữa các ký tự.
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          +       Backspace  : Xo¸ c¸c kÝ tù ë bªn tr¸i con trá (cursor).


+  Del: Delete xo¸ c¸c kÝ tù t¹i vÞ trÝ con trá.

- Nếu xoá nhiều ký tự, ta chọn khối ký tự muốn xoá (bôi đen) và nhấn phím Delete trên bàn phím hoặc nút Cut trên thanh công cụ (biểu tượng hình [image: image4.png]


).

+ Muốn xoá khoảng trắng giữa 2 dòng ta đặt dấu chèn vào cuối dòng trên bấm phím Delete hoặc đặt dấu chèn vào đầu dòng của đoạn văn bản dưới bấm phím Backspace.

+ Để đẩy các ký tự hoặc dòng văn bản sang bên phải ta đặt dấu chèn vào trước ký tự. Dùng phím Tab hoặc phím Space (phím dài nhất trên bàn phím) để đẩy.
3) C¸c thao t¸c di chuyÓn con trá (cursor) trong Word

--> Space: PhÝm c¸ch (T¹o kho¶ng c¸ch gi÷a c¸c tõ).

--> Enter: Dïng ®Ó kÕt thóc mét ®o¹n v¨n b¶n (Paragraph…).
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--> Tab: Di chuyÓn con trá (cursor) mét kho¶ng Tab.

--> C¸c phÝm mòi tªn                           di chuyÓn con trá theo c¸c h­íng.

--> Home: Di chuyÓn con trá (cursor)  vÒ ®Çu dßng.

--> End: Di chuyÓn con trá vÒ cuèi dßng.

--> Page Up vµ Page Down: LËt ®i lËt l¹i mét trang mµn h×nh (Monitor).

--> Ctrl + Home: §­a con trá vÒ ®Çu v¨n b¶n.

--> Ctrl + End: §­a con trá vÒ cuèi v¨n b¶n.
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--> Ctrl +                  : §­a con trá trë ®i trë l¹i kÝ tù ®Çu cña ch÷.

--> BÊm chuét t¹i mét vÝ trÝ bÊt k× trong v¨n b¶n.

4) Nh÷ng l­u ý khi so¹n th¶o v¨n b¶n

-  Ngay khi so¹n th¶o v¨n bản bắt đầu vào soạn thảo để đề phòng các sự cố mất điện, sự cố về phần mềm… ta nên lưu văn bản ngay từ đầu. Sau này soạn thảo đến đâu ta lưu tiếp đến đó.

- Khi soạn thảo văn bản không nên vừa đánh máy vừa trang trí văn bản. Việc trang trí chỉ nên làm khi đã soạn thảo xong. (nhËp v¨n b¶n ë d¹ng th« sau khi đã soạn thảo xong míi chØnh xöa).
- Khi so¹n th¶o v¨n b¶n ®»ng sau dÊu chÊm ph¶i viÕt hoa.

- DÊu chÊm, dÊu phÈy ph¶i viÕt s¸t vµo kÝ tù cuèi cïng cña c©u.

Bµi 4:  C¸ch ghi v¨n b¶n so¹n th¶o vµo ®Üa
1) Ghi v¨n b¶n vµo ®Üa cøng hoÆc USB
V¨n b¶n sau khi so¹n th¶o xong ®­îc l­u vµo mét tÖp (File) ®­îc ®Æt ngÇm ®Þnh trong th­ môc My Documents.

--> File --> Save… (Ctrl + s, hoÆc click mouse  [image: image5.bmp] ) xuÊt hiÖn hép tho¹i lóc nµy b¹n ®Æt tªn file ë hép File name --> Save.
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*  L­u ý: b¹n còng cã thÓ l­u vµo æ kh¸c nh­ æ di ®éng USB hoÆc æ D:\  æ E:\ hoÆc mét th­ môc nµo ®ã n»m trong c¸c æ trªn b»ng c¸ch b¹n chän tªn æ hoÆc th­ môc n»m  trong  môc Save in:……………..

2) Ghi file võa so¹n th¶o víi tªn kh¸c

--> File --> Save As… hoÆc Ên phÝm (F12) xuÊt hiÖn hép tho¹i lóc nµy b¹n ®Æt tªn file ë hép File name --> Save

* L­u ý: 

- Mçi file cã mét tªn kh¸c nhau kh«ng ®­îc trïng nhau trong cïng mét môc.

- L­u file lÇn  ®Çu th× m¸y yªu cÇu ®Æt tªn file tõ nh÷ng lÇn sau m¸y kh«ng yªu cÇu ®Æt tªn n÷a. 

- B¹n cÇn ®Æt tªn file theo néi dung dÔ nhí cña néi dung file ®Ó dÔ cho viÖc tra cøu sau nµy. 

- B¹n còng cã thÓ t¹o c¸c th­ môc kh¸c nhau chøa cïng mét néi dung ®Ó chøa c¸c file vµo trong ®ã.
3) Ghi  v¨n b¶n  vµo USB


C1: B¹n ®ãng file ®ã l¹i vµ bÊm chuét ph¶i ë file ®ã råi chän Send To ( råi chän göi ®Õn USB 

C2: B¹n ®ãng file ®ã l¹i vµ bÊm chuét ph¶i vµo file ®ã chän Copy råi më USB bÊm chuét ph¶i vµo khu vùc mµn h×nh trèng  chän   Pate


C3: B¹n lµm nh­ môc 1) or  2) nh­ trªn råi chän  n¬i l­u lµ USB
4) Chó ý:

NÕu b¹n so¹n th¶o xong mét v¨n b¶n mµ quyªn ch­a ®Æt tªn file hoÆc khi so¹n th¶o xong mµ ch­a l­u tiÕp vµo mµ ®· ®ãng file l¹i th× Word sÏ ®­a ra mét th«ng b¸o hái b¹n nh­ sau: ???
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®Õn ®©y b¹n h·y chän mét trong 3 yªu cÇu trªn.
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* Tham khảo.    Cách gõ tiếng Việt với bộ gõ VNI:


Font VNI do công ty Vietnam International (USA) phát triển, là font chữ 2 byte thường được sử dụng trong khu vực phía Nam và ở nước ngoài. Font này thường bắt đầu bằng chữ: VNI-xxx.TTF. Ví dụ: VNI-Time...
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- Phím số số 1
=
Dấu sắc              


- Phím số số 2
=
Dấu huyền            


- Phím số số 3
= 
Dấu hỏi


- Phím số số 4
= 
Dấu ngã             


- Phím số số 5
= 
Dấu nặng               


- Phím số số 6
= 
Dấu mũ của chữ â, ê và ô        


- Phím số số 7
= 
Dấu râu của chữ ơ và ư


- Phím số số 8
= 
Dấu trăng của chữ ă


- Phím số số 9
= 
Dấu gạch ngang của chữ đ     

- Phím số số 0        = 
Khử dấu (xoá dấu)                   

 Ví dụ:

 Gõ dòng chữ


Nước chảy đá mòn

bằng dãy các phím sau:


Nu7o71c  cha3y d9a1 mo2n
 hoặc


Nu7o7c1  chay3 d9a1 mon2

 Dùng phím <Ctrl> để gõ các chữ số và các ký tự <!,@.#,(,)..> sau các nguyên âm.

Ví dụ:
A!
= A<Ctrl>!
	5) Lưu ý: Gõ tiếng Việt với Font Unicode.


Font Unicode với kích thước mã gấp 256 lần so với các mã 8-bit hiện hành (TCVN 5712, VNI ...) Unicode (16-bit) có đầy đủ các ký tự tiếng Việt và khắc phục được các lỗi tranh chấp với các ký tự điều khiển (mất chữ ư, ơ, ả ... trong TCVN, VNI ...)

Các văn bản tiếng Việt được soạn bởi font Unicode sẽ hiển thị chính xác tiếng Việt dù có được mở bằng bất cứ máy tính nào trên thế giới có sử dụng Unicode. Việc chuyển sang sử dụng font Unicode của Việt Nam là một điều tất yếu. Bộ Khoa học - CNMT đã chính thức phê chuẩn việc sử dụng bộ font  Unicode 16-bit thống nhất trên toàn quốc.

Các máy tính dùng hệ điều hành Windows 98SE, ME, 2000, XP hoặc có cài Office 2000, XP, Office 2003 đã có sẵn các font Unicode: Arial, Courier New, Microsoft Sans Serif, Palatino Linetype, Tahoma, Time New Roman, ....

Có hai cách để gõ tiếng Việt bằng font Unicode:

+ Sử dụng các bộ gõ tiếng Việt hỗ trợ Unicode như: Unikey, Vietkey 2000...

+ Sử dụng keyboard có sẵn của Windows 2000, Windows XP ...

Tuy nhiên, do việc sử dụng keyboard có sẵn của Windows hơi phức tạp vì bộ gõ này có qui định kiểu gõ riêng nên việc sử dụng bộ gõ tiếng Việt có hỗ trợ Unicode là lựa chọn tốt nhất.
+ Cách gõ Unicode với bộ gõ Unikey:

- Các máy tính cài bộ gõ Unikey có thể sử dụng font Unicode bằng cách:
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1- Bấm phải chuột vào biểu tượng Unikey [image: image8.png]


 ở khay đồng hồ (góc dưới, bên phải màn hình) chọn kiểu gõ TELEX, bộ gõ Unicode.
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2- Trong cửa sổ màn hình soạn thảo văn bản Word chọn phông chữ Unicode. Ví dụ: Arial, Courier New, Microsoft Sans Serif, Palatino Linetype, Tahoma, Time New Roman, Verdana....

- Khi đã chọn đủ hai điều kiện trên, việc gõ tiếng Việt với phông chữ Unicode vẫn dùng cách gõ Telex hoặc VNI như bình thường.

* Có thể thay đổi cách gõ trong cửa sổ chính của chương trình Unikey:

+ Cho hiện cửa sổ Unikey bằng cách:

- Bấm phím phải chuột vào biểu tượng Unikey [image: image9.png]


 ở khay đồng hồ (góc dưới, bên phải màn hình) chọn Bảng điều khiển...[CS+F5]
- Chọn kiểu gõ: Telex và bảng mã: Unicode dựng sẵn.
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2.   Cách gõ 10 ngón: tập luyện với phần mềm MARIO Teaches typing

+ Cách đặt tay trên bàn phím (với bàn phím tiêu chuẩn): 

                   - Bàn tay trái:  Ngón út - A

Ngón áp út - S

Ngón giữa - D
Ngón trỏ - F

        - Bàn tay phải: Ngón trỏ - J

Ngón giữa - K
Ngón áp út - L
Ngón út - :


+ Vị trí gõ các phím của các ngón tay:

                 - Bàn tay trái: Ngón út: Shift, 1, Q, A, Z
Ngón áp út: 2, W, S, X
Ngón giữa: 3, E, D, C
Ngón trỏ: 4, 5, R, T, F, V, B

                - Bàn tay phải: Ngón trỏ: 6, 7, Y, U, H, J, N, M
    Ngón giữa: 8, I, K, ,
    Ngón út: 0, -, =, Backspace, P, [, ], \, ;, Enter, /, 

- Ngón tay cái của một trong hai tay dùng để gõ phím Space Bar.
Bµi 5: B¶o vÖ tËp tin b»ng mËt khÈu
(: Để bảo vệ những tập tin quan trọng ta có thể đặt mật khẩu.

1. Nhấn Menu File chọn Save As.
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2. Nhấn Tools chọn Security Options.
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3. Trong hộp Password to open (Mật khẩu để mở) gõ mật khẩu vào, nhấn OK.

4. Xác nhận lại mật khẩu trong hộp Password to Modify, nhấn OK.

5. Nhấn Save để ghi tập tin vào đĩa. Tập tin đã được đặt mật khẩu.

* Lưu ý: hiện nay đã có các phần mềm dò tìm được mật khẩu. Để gây khó khăn cho các phần mềm này thì mật khẩu được đặt phải có độ dài tối thiểu là 7 ký tự, nên dùng kết hợp: chữ, số, các ký tự đặc biệt ...
Bµi 6: Lçi tiÕng ViÖt - t¹o th­ môc
1) Gâ kh«ng ra tiÕng ViÖt

B¹n gâ ®óng nh­ng vÉn kh«ng ra tiÕng ViÖt lçi nµy cã nhiÒu nguyªn nh©n b¹n h·y kiÓm tra c¸c nguyªn nh©n sau:

[image: image117.png]


* B¹n ch­a khëi ®éng VietKey  c¸ch gâ tiÕng ViÖt, 

b¹n h·y Double click vµo biÓu t­îng VietKey 2000
a) --> KiÓu gâ --> Telex --> Chän tiÕng viÖt --->  tiÕng anh

b) --> B¶ng m· --> TCVN-ABC(.Vn time…)

c) --> Tïy chän --> Vietnamese Interfece --> khëi ®éng nhanh --> QuÐt 3 kÝ tù

d)  --> C«ng cô -->  Lu«n ch¹y Vietkey khi khëi ®éng PC


===> Sau ®ã b¹n chän môc TaskBar hoÆc Lu«n næi
* M¸y kh«ng cã biÓu t­îng VietKey 2000 nguyªn nh©n do ch­a cµi ®Æt Font ch÷ tiÕng ViÖt th× b¹n h·y liªn hÖ víi ng­êi biªn so¹n s¸ch ®Ó ®­îc gióp ®ì cµi ®Æt.
2) Th­ môc vµ tËp tin
a. Th­ môc lµ g×?:

* Lµ n¬i chøa néi dung vÒ mét lo¹i hay nhiÒu lo¹i th«ng tin nµo ®ã do ng­êi dïng t¹o ra ®Ó dÔ rµng cho viÖc qu¶n lý, tra cøu, t×m kiÕm th«ng tin, Th­ môc ®­îc t¹o ra d­íi d¹ng h×nh c©y. VÝ dô nh­ trong mét th­ viÖn ng­êi ta sÏ ph¶i ph©n ra: Lo¹i s¸ch - KiÓu s¸ch - S¸ch….

* C¸ch t¹o th­ môc: tõ nÒn mµn h×nh Decktop --> My Computer  --> B¹n chän n¬i chøa c¸c th­ môc cã thÓ lµ æ C:\  hoÆc D:\  hoÆc E:\  tuú ë b¹n. 

Sau ®ã b¹n bÊm chuét ph¶i ë chç mµn h×nh trèng (mµu tr¾ng) --> New --> Folder --> lóc nµy b¹n ®Æt tªn míi tuú b¹n. B¹n còng cã thÓ më th­ môc võa t¹o ra ®Ó t¹o tiÕp c¸c th­ môc con trong th­ môc võa t¹o ra ®ã chÝnh lµ h×nh c©y cña th­ môc.
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b. TËp tin lµ g×?:

V¨n b¶n sau khi so¹n th¶o xong ®­îc l­u vµo mét (tËp tin - tÖp) tiÕng Anh gäi lµ (File). Mçi mét File cã mét tªn kh¸c nhau do ng­êi dïng ®Æt ®Ó dÔ nhí trong viÖc tra cøu vµ t×m kiÕm sau nµy.

- VÝ dô: Don xin lay chong.doc - §©y file cña Word

- VÝ dô: Bang luong thang.xls - §©y file cña Excel

Bài 7: TẠO THỤT ĐẦU DÒNG 
VÀ CÁCH DÒNG TỰ ĐỘNG CHO VĂN BẢN

(: Có tác dụng khi kết thúc một đoạn văn bản, nhấn Enter để xuống dòng thì chương trình sẽ tự động thụt đầu dòng mới vào và tạo khoảng cách giữa dòng trên và dòng dưới. Giúp cho quá trình soạn thảo văn bản nhanh đẹp hơn.
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1. Chọn đoạn văn bản cần tạo thụt đầu dòng và cách dòng tự động (Với văn bản mới thì bỏ qua bước này). 
2. Nhấn Menu Format chọn Paragragh.

3. Trong hộp xổ xuống Special chọn First line.(Tạo thụt đầu dòng)

4. Trong lựa chọn Spacing chọn Before tăng khoảng cách giữa hai đoạn văn bản lên 6 pt hoặc 8 pt tuỳ ý (tạo khoảng cách giữa 2 dòng).

5. Nhấn OK để xác nhận. 
Ch­¬ng II: 


Thanh vµ nót c«ng cô
Bµi 1: Thanh thùc ®¬n Menu
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1. File -----(C¸c lÖnh vÒ tÖp)
New---- Më tÖp míi (Ctrl + N)
Open --- Më tÖp ®· cã (Ctrl  + O)
Close --- §ãng

Save --- l­u file (Ctrl + S)
Save As ---- L­u file víi tªn kh¸c (F12)
Page setup --- ®Þnh d¹ng trang in
Print Prewiew --- Xem tr­íc khi in
Print --- In v¨n b¶n (Ctrl - P)
2. Edit --- (So¹n th¶o)
Undo Typing --- Trë l¹i thao t¸c võa thùc hiÖn (Ctrl + z)
Repeat Typing ---- Trë l¹i thao t¸c võa Undo (Ctrl + y)
Cut --- C¾t ®o¹n v¨n b¶n vµo bé nhí (Ctrl + X)
Copy --- Copy ®o¹n v¨n b¶n ®· b«i ®en

Paste --- D¸n ®o¹n v¨n b¶n ®· Copy hoÆc Cut
Seleck All --- Chän toµn bé v¨n b¶n (Ctrl + A)

Find --- T×m  kiÕm vµ thay thÕ (Ctrl + F)

3. View --- (Xem)
Ruler --- Th­íc
Toolbars --- Èn hiÖn c¸c thanh c«ng cô

Header and Foorter --- Tiªu ®Ò ®Ønh vµ ®¸y
4. Insert --- (ChÌn)

Page Numbers... --- ChÌn sè trang
Date and Time --- ChÌn ngµy vµ giê
Symbol.. --- ChÌn kÝ tù l¹

Piture -- ChÌn bøc tranh

Object… ---  ChÌn ®èi t­îng

5. Format --- (§Þnh d¹ng)
Font… --- (Ph«ng ch÷)
Paragraph.. --- (§o¹n v¨n b¶n)

Bullets and Numbering... --- (H¹t ®Ëu vµ sè)-®¸nh sè thø tù tù ®éng
Borders and Shading... --- (T¹o ®­êng viÒn cho luËn v¨n)
Columns --- Chia cét

Tabs.. --- T¹o mét kho¶ng di chuyÓn Tab
Drop Cap --- T¹o ch÷ hoa lín ®Çu dßng

Text Direction... T¹o ch÷ quay däc trong b¶ng
6. Tools ---- (Tïy chän)
Auto Correct Options... T¹o ch÷ viÕt t¾t
7. Table --- (B¶ng)
Draw Table --- VÏ b¶ng

Insert --- ChÌn b¶ng

Delete --- Xãa cét, dßng, b¶ng khi ®· chän

Select --- Chän

Merge Cells --- Chén cét trong b¶ng

Split Cells --- Chia cét trong b¶ng

Sort --- s¾p xÕp

Formula --- C«ng thøc

8. Windows --- (Cöa sæ)

9. Help --- (Trî gióp)
Bµi 2: Thanh c«ng cô chuÈn 
 Standard
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	1- Më v¨n b¶n míi

2- Më v¨n b¶n ®· cã

3- Ghi v¨n b¶n

4- KÕt nèi Internet

5- In v¨n b¶n

6- Xem tr­íc khi in

7- KiÓm tra chÝnh t¶

8- T×m kiÕm

9- C¾t ®o¹n v¨n b¶n

10- Copy ®o¹n v¨n b¶n

11- D¸n ®o¹n v¨n b¶n
	12- Chæi s¬n

13- Undo
14- Redo

15- Liªn kÕt

16- Èn hiÖn b¶ng Tables and borders

17- T¹o b¶ng

18- ChÌn b¶ng Excel

19- Chia cét

20- Èn hiÖn thanh céng cô vÏ
21- HiÖn ch÷ ¶

22- Sè phÇn tr¨m ®Ó xem


Bµi 3: Thanh ®Þnh d¹ng
Formatting
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	1
	2
	3
	4
	5
	6
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	1- KiÓu ch÷

2- KiÓu font ch÷

3- Cì ch÷

4- Ch÷ ®Ëm

5- Ch÷ nghiªng

6- Ch÷ G¹ch ch©n

7- C¨n lÒ tr¸i

8- C¨n vµo gi÷a

9- C¨n lÒ ph¶i
	10- C¨n ®Òu hai bªn

11- T¹o kho¶ng c¸ch dan dßng
12- §¸nh sè thø tù

13- §¸nh h¹t ®Ëu

14- §Èy khèi b«i ®en trang tr¸i, ph¶i

15- T¹o ®­êng viÒn 

16- §¸nh dÊu ®o¹n v¨n b¶n

17- Chän mµu cho ch÷


Bµi 4: Thanh c«ng cô b¶ng vµ ®­êng viÒn
Tables and Borders
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	1- VÏ b¶ng

2- TÈy b¶ng

3- KiÓu ®­êng kÎ

4- §é réng ®­êng kÎ

5- HiÖn b¶ng Borders and shading
6- Lùa chän viÒn khung trong

7- §æ mµu cho b¶ng

8- ChÌn b¶ng


	9- Chén cét, dßng

10- Chia cét, dßng

11- C¨n lÒ ch÷ trong b¶ng

12- T¹o kho¶ng d·n ®Òu nhau gi÷a dßng vµ cét

13- ChÌn b¶ng tù ®éng

14- Thay ®æi kiÓu quay ch÷ trong b¶ng

15- S¾p sÕp trong b¶ng

16- TÝnh tæng


Bµi 5: Thanh c«ng cô vÏ
Drawing
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	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12
	13
	14
	15
	16
	17
	18
	   19

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	


	1- Cã nhiÒu tïy chän
2- Gom c¸c ®èi t­îng thµnh mét nhãm

3- C¸c khu«n mÉu t¹o s½n

4- VÏ ®­êng th¼ng
5- VÏ mòi tªn

6- VÏ h×nh ch÷ nhËt

7- VÏ h×nh « van

8- VÏ hép Text Box

9- T¹o ch÷ nghÖ thuËt

10- ChÌn c¸c biÓu ®å
	11- ChÌn Clip Art
12- ChÌn tranh
13- §æ mµu
14- T« mµu

15- Chän mµu ch÷

16- KiÓu dßng kÎ

17- KiÓu dßng vÏ

18- VÏ c¸c d¹ng mòi tªn

19- §æ bo¸ng cho c¸c h×nh


Ch­¬ng III: 

§Þnh d¹ng v¨n b¶n trong Windows

Bµi 1: C¸c thao t¸c ®Þnh d¹ng v¨n b¶n trong Word
* Muèn ®Þnh d¹ng mét ®o¹n v¨n b¶n (Paragraph) hay c¶ v¨n b¶n b¹n cÇn chän v¨n b¶n hay ®o¹n v¨n b¶n b»ng c¸ch b«i ®en.

* C¸c c¸ch chän ®o¹n v¨n b¶n

C1: Gi÷ chuét råi giª chuét ®Õn hÕt ®o¹n v¨n b¶n cÇn ®Þnh d¹ng råi nh¶ chuét.

C2: Gi÷ phÝm Shift + C¸c phÝm di chuyÓn con trá
1) §Þnh d¹ng Font ch÷ (Format)

Chän ®o¹n v¨n b¶n cÇn ®Þnh d¹ng --> Format --> Font... 
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Sau khi chän vµo Font m¸y tÝnh sÏ xuÊt hiÖn hép tho¹i Font.

(HoÆc b«i ®en ®o¹n v¨n b¶n nhÊn ®ång thêi hai phÝm Ctrl + D). Lóc nµy ë ®©y b¹n cã thÓ chän c¸c lo¹i Font ch÷.

+ NÕu lµ ch÷ ViÖt Nam kiÓu ch÷ in th­êng b¹n h·y chän c¸c kiÓu cã ch÷ Vn…… ë ®»ng tr­íc nh­ VnTime.

+ NÕu lµ ch÷ ViÖt Nam kiÓu ch÷ in hoa b¹n còng chän c¸c kiÓu cã ch÷ Vn…… ë ®»ng tr­íc, nh­ng ®»ng sau kiÓu ch÷ ®ã cã ch÷ H nh­ VnTimeH.

+  ë ®©y b¹n còng cã thÓ chän kiÓu ch÷ th­êng (Regular), nghiªng (Italic), ®Ëm (Bold), ®Ëm nghiªng (Italic Bold) hoÆc kÝch cì ch÷ ë « Size.
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+ VD: ®Þnh d¹ng ch÷ nh­ sau font VnTme cì ch÷ 14: Ch©u ¸.  Ên §é D­¬ng.  ¶nh ®Ñp.

+ VD: ®Þnh d¹ng ch÷ nh­ sau font VnTme cì ch÷ 15: H«m nay lµ thø 7 kh«ng cã ng­êi yªu!

 + VD: ®Þnh d¹ng ch÷ nh­ sau font VnUniverse cì ch÷ 16 ®Ëm: Ên phÝm Space ®Ó t¹o kho¶ng c¸ch.

+ VD: ®Þnh d¹ng ch÷ nh­ sau font VnMonotype corsiva cì ch÷ 17: BËt c«ng t¾c nguån (Power) ë CPU - Cetral Processing Unit.

2) C¸c thao t¸c c¾t (Cut), d¸n (Paste), sao chÐp (Copy)

- C¾t ®o¹n v¨n b¶n: Chän ®o¹n v¨n b¶n cÇn c¾t --> Edit --> Cut    (Ctrl + x hoÆc click vµo logo [image: image18.bmp]).

- D¸n ®o¹n v¨n b¶n võa c¾t:  §­a con trá ®Õn n¬i cÇn d¸n --> Edit       --> Paste (Ctrl + v hoÆc click vµo logo [image: image19.bmp]).

- Sao chÐp ®o¹n v¨n b¶n:  Chän ®o¹n v¨n b¶n sao chÐp  --> Edit         --> Copy (Ctrl + c hoÆc click vµo logo [image: image20.bmp]).  Sau ®ã ®­a con trá ®Õn n¬i cÇn d¸n --> Edit --> Paste (Ctrl + v hoÆc click vµo logo [image: image21.bmp]).

3) T¹o ®­êng viÒn khung cho luËn v¨n

--> Format -->  Borders and shading... --> Page border ë ®©y b¹n sÏ chän kiÓu ®­êng viÒn, chän kho¶ng c¸ch viÒn bao quanh luËn v¨n --> Options...
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Bµi 2: C«ng thøc To¸n - Lý - Ho¸
1) Gâ chØ sè trªn, chØ sè d­íi:

VD:
 H2SO4  or  5x2 + (-3x2) = 1

- ChØ sè d­íi 
Ctrl + =

- ChØ sè trªn 
Ctrl + Shift + =

MÑo: B¹n cã thÓ nhËp ë d¹ng H2SO4 sau ®ã b«i ®en råi gâ chØ sè trªn or chØ sè d­íi.

2) ChÌn  (Insert) kÝ tù l¹ (Symboy) trong v¨n b¶n

- Chän n¬i cÇn chÌn -->Insert -->Symbol...
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khi xuÊt hiÖn hép tho¹i Insert b¹n chän c¸c kÝ tù cÇn chÌn Ên vµo Insert, chÌn xong b¹n bÊm vµo Close ®Ó ®ãng l¹i.

2) §¸nh c«ng thøc To¸n - Lý - Ho¸

--> Insert --> 0bject... --> Create New --> Microsoft Equetion 3.0...
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ë ®©y b¹n chän c¸c kiÓu c«ng thøc cÇn chÌn c«ng thøc sÏ hiÖn lªn ë « ®ãng khung nh­ trong vÝ dô. ë ®©y b¹n dïng c¸c phÝm mòi tªn ®Ó di chuyÓn con trá råi ®¸nh c«ng thøc.

* L­u ý b¹n ®· lµm ®óng nh­ trªn nh­ng m¸y cña b¹n kh«ng thÊy dßng ch÷  Microsoft Equetion 3.0... ®Ó ®¸nh c«ng thøc To¸n - Lý - Ho¸. Nguyªn nh©n do m¸y cña b¹n ch­a cµi ®Æt Microsoft Equetion 3.0... th× b¹n  h·y liªn hÖ víi ng­êi biªn so¹n s¸ch ®Ó ®­îc gióp ®ì cµi ®Æt.
Bµi 3: C¸c thao t¸c ®Þnh d¹ng cÊp cao
1) T¹o kho¶ng c¸ch d·n dßng trong v¨n b¶n

--> Format --> Paragraph... ë « Indents and Spacing
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2) Chän c¨n  lÒ  cho v¨n b¶n --> File --> Page setup...  --> Margins
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LÒ trªn (Top), lÒ d­íi (Bottom), lÒ tr¸i (Left), lÒ ph¶i (Right).

3) Chän khæ giÊy cho m¸y in

--> File --> Page setup...  --> Pager...
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B¹n cã thÓ chän c¸c khæ giÊy A3, A4 ë « Page

ë môc thùc ®¬n däc Margins b¹n cã thÓ chän giÊy däc ë « (Portrait), giÊy ngang ë « (landscape) --> OK 
4) §¸nh sè trang

--> Insert -->Page Numbers... 

Sau ®ã b¹n chän kiÓu ®¸nh sè trang ë trªn hoÆc ë ®­íi ë trong « Position.

 Sau ®ã b¹n chän kiÓu ®¸nh sè trang ë bªn ph¶i, bªn tr¸i, ë gi÷a, hoÆc chän kiÓu in sè trang ë bªn tr¸i råi trang bªn ph¶i trong « Alignment:

5) ThiÕt lËp trang ®øng trang n»m
B¹n muèn thiÕt lËp trang thø 1 ®øng trang thø 2 nµm trang thø 3 ®øng... ta lµm nh­ sau:

§Æt con trá vµo ch÷ cuèi cïng cña hµng cuèi cïng trong trang tr­íc v× trang sau sÏ lµ chÝnh lµ trang b¹n ®Þnh thay ®æi kiÓu trang ®øng hoÆc trang n»m. 

--> Insert --> Beak...

--> Next page --> OK


--> File --> Page setup...



--> Paper Size 

(ë ®©y b¹n chän 

kiÓu quay däc hoÆc 

quay ngang nh­ ë phÇn 3
 råi b¹n chän OK)

L­u ý: b¹n muèn thay ®æi c¸c trang tiÕp theo th× b¹n sÏ ph¶i lµm còng sÏ ph¶i lµm l¹i tõng b­íc nh­ trªn.

6) Xem tµi liÖu tr­íc khi in

Khi chän môc nµy b¹n sÏ nh×n thÊy ®­îc toµn c¶nh v¨n b¶n cña b¹n sÏ ®­îc in ra giÊy.

C1: --> File --> Print Prewiew  ®Ó xem ë ®©y b¹n còng cã thÓ nh¸y chuét vµo « [image: image28.bmp] Magnifier ®Ó chØnh l¹i cho ®óng ý b¹n xem song b¹n chän Close ®Ó ®ãng l¹i råi in.

C2: Click mouse [image: image29.bmp] xem song b¹n chän Close ®Ó ®ãng l¹i råi in.

7) C¸c thao t¸c in Ên
a. In giÊy mét mÆt. 
Më file v¨n b¶n cÇn in ra
 C1: --> File --> Print...
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ë « nµy  b¹n chän kiÓu m¸y in cho phï hîp m¸y in cña b¹n.



In tÊt c¶ v¨n b¶n (M¸y ®Æt ngÇm ®Þnh).



In trang hiÖn thêi ®Æt con trá.





In sè trang tuú chän VD: 1,3,4,6-9


In sè ®o¹n v¨n b¶n ®­îc b«i ®en.



Sè l­îng b¶n in b¹n cÇn. 


( Khi chän xong b¹n -->OK

C2: Nh¸y chuét vµo biÓu t­îng  m¸y in Print  [image: image31.bmp]
C3: NhÊn ®ång thêi hai phÝm Ctrl + P sau ®ã b¹n chän nh­ c¸ch 1
b. Muèn in giÊy hai mÆt

- B1: B¹n cÇn chÌn sè trang sao cho trang in lu«n ë phÝa gãc ngoµi cña v¨n b¶n (Insert ( Page Numbers… ( Alignment ( Inside ( OK.

- B2: --> File --> Page Setup… råi chän Mirror margins nh­ h×nh vÏ

- B3: --> File --> Print...
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B¹n chän in c¸c trang lÎ tr­íc, khi in xong bËn h·y ®¶o giÊy ng­îc l¹i óp giÊy xuèng theo thø tù 1, 3, 5….. råi quay ng­îc ®Çu in vµo trong chän in tiÕp c¸c trang ch½n 
Ch­¬ng IV: 



B¶ng  biÓu (Table) trong Word
Bµi 1: T¹o b¶ng
1. T¹o b¶ng biÓu
§Æt con trá ®Õn n¬i cÇn t¹o b¶ng

C1: --> Table --> Insert --> Table….. 
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(XuÊt hiÖn hép tho¹i)
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ë ®©y b¹n chän sè dßng, sè cét cÇn cã cña b¶ng råi bÊm --> OK

C2: Trªn thanh c«ng cô chuÈn (Formatting)

- §Æt con trá ®Õn n¬i cÇn t¹o b¶ng. B¹n chän biÓu t­îng Insert table. Råi sau ®ã b¹n kÐo vµ dª chuét ®Ó chän sè « vµ sè cét cÇn thiÕt råi nh¶ chuét (Nh­ h×nh vÏ)
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2. C¸c thao t¸c Èn vµ hiÖn thanh c«ng cô vÒ b¶ng vµ ®­êng viÒn
(Table and borders)

C¸ch 1:   

B1: HiÖn thanh c«ng cô cña b¶ng -->View --> Toolbars --> Table and borders  (§¸nh dÊu kiÓm vµo môc Table and borders - Nh­ h×nh vÏ)
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B2: BÊm chuét vµo thanh Table and borders phÇn trªn cã mµu xanh råi ®­a lªn phÝa trªn c¸c thanh c«ng cô chuÈn (Trong mét sè tr­êng hîp Windows tù thùc hiÖn thao t¸c nµy cho chóng ta).  

C¸ch 2: 

§­a chuét lªn phÝa c¸c thanh c«ng cô chuÈn råi bÊm chuét ph¶i sau ®ã b¹n (§¸nh dÊu kiÓm vµo môc Table and borders) råi tiÕp tôc thùc hiÖn c¸c thao t¸c nh­ B2

Bµi 2: C¸c thao t¸c chØnh söa trong b¶ng
1) Chén «, chia « 

- Chén « (B«i ®en c¸c « cÇn trén trong b¶ng råi chän Merge Cells) 
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- Chia « (BÊm chuét ë « cÇn chia nhá trong b¶ng råi chän Splip Cells sau ®ã b¹n chän chia nhá thµnh bao nhiªu cét hoÆc bao nhiªu dßng råi bÊm OK h×nh trªn)

2) C¨n ®Òu ch÷ trong «
- Chän c¸c « cÇn c¨n ®Òu ch÷ 

trong b¶ng sau ®ã bÊm vµo c¸c 

« h×nh tam gi¸c tõ ®ã b¹n chän c¸c 

Logo ®Ó c¨n theo ý muèn -  Nh­ h×nh vÏ

3) T¹o ch÷ däc trong b¶ng

VÝ dô nh­

	STT
	Hä vµ tªn
	§¬n vÞ c«ng t¸c

	
	
	


- B¹n nhËp ch÷ ë d¹ng th«
(NhËp ®ñ th«ng tin ë « cÇn quay däc ch÷) 
- B«i ®en « cÇn quay 

--> Format 

-->Text Direction…..

( XuÊt hiÖn hép tho¹i 

ë ®©y b¹n chän kiÓu 

quay däc hay ngang tuú 

b¹n muèn --> råi OK h×nh bªn)

4) Thªm dßng, cét trong b¶ng, xo¸ dßng, cét trong b¶ng

- B«i ®en c¶ dßng hoÆc 

c¶ cét phÇn « gÇn n¬i cÇn 

chÌn thªm cét hoÆc dßng råi 

thùc hiÖn c¸c thao t¸c sau:

 --> Table --> Insert  

tõ ®©y b¹n chän theo c¸c biÓu t­îng

5) ChØnh ®é réng trong b¶ng

- BÊm chuét vµo mét « bÊt kú trong b¶ng råi ®­a chuét lªn trªn th­íc däc hoÆc th­íc ngang khi chuét biÕn thµnh mòi tªn hai chiÒu råi bÊm chuét kÐo dª ®Õn ®é réng thÝch hîp råi nh¶ chuét 

- ChØ chuét vµo ®­êng kÎ trong b¶ng khi chuét biÕn thµnh mòi tªn hai chiÒu ta bÊm chuét kÐo dª ®Õn ®é réng thÝch hîp råi nh¶ chuét
Chương V:
T¹o c¸c v¨n b¶n nghÖ thuËt
1.VÏ h×nh Paint

- Khëi ®éng - Paint 

- Tõ nÒn mµn h×nh Decktop  --> Start --> Program -- > Accessories   --> Paint  ë ®©y b¹n cã thÓ vÏ h×nh häc, vÏ hoa theo ý muèn råi dïng khung « vu«ng chän h×nh ®· vÏ råi Copy sang Word.
2. T¹o kiÓu ch÷ nghÖ thuËt nhê WordArt
--> Insert --> Picture --> Wordart... ë ®©y b¹n chän c¸c kiÓu ch÷ nghÖ thuËt -- OK
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Sau khi chän OK suÊt hiÖn hép tho¹i cña WordArt Text råi b¹n chän Font ch÷ tiÕng viÖt sau ®ã b¹n gâ dßng ch÷  cÇn t¹o nghÖ thuËt vµo « Text  --> OK. B¹n còng cã thÓ  chän cì ch÷, kiÓu ch÷.


Sau khi t¹o ch÷ ngÖ thuËt song cã thÓ click vµo ch÷ t¹o thµnh 8 chÊm ®en vµ ®­a chuét vµo ®ã t¹o thµnh mòi tªn hai chiÒu bÊm vµ kÐo dª chuét ®Ó b¹n chØnh l¹i theo ý muèn.
3. øng dông vÏ biÓu ®å

VÝ dô vÏ biÓu ®å vÒ tØ lÖ t¨ng, gi¶m d©n sè ë n­íc ta trong c¸c n¨m ë 3 khu vùc Thµnh thÞ. N«ng th«n, trung du-MiÒn nói ®­îc cho bëi b¶ng sau:

	N¨m

Khu vùc
	2005
	2006
	2007

	Thµnh thÞ
	12
	13.9
	13.7

	N«ng th«n
	20.3
	26.2
	25.3

	Trung du - MiÒn nói
	18.2
	20.9
	19.2


--> Insert --> Picture --> Chart...(xuÊt hiÖn hép tho¹i b¹n nhËp c¸c sè liÖu vµo ®ã Word se tù ®­a ra b¶ng nh­ vÝ dô).
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4. ChÌn (Insert) h×nh ¶nh (Picture) vµo v¨n b¶n

(: Chèn các ảnh có sẵn vào để trang trí văn bản.
- Chọn vị trí sẽ chèn ảnh.

-. Nhấn Menu Insert chọn Picture, chọn tiếp Clip Art. Nhấn Organize clips để chọn các ảnh được đặt ở thư mục khác.
-. Chọn ảnh cần chèn sau đó nhấn phải chuột chọn Copy và đặt con trỏ chuột vào vị trí muốn chèn ảnh, phải chuột chọn Paste để chèn ảnh vào văn bản. 

-. Khi đã chọn xong nhấn Close để đóng lại. 
5. ĐỂ ẢNH LÀM NỀN MỜ CHO VĂN BẢN
-. Chèn ảnh vào văn bản.

-. Nhấn phải chuột trên ảnh chọn Show Picture Toolbar để hiện thanh công cụ chỉnh sửa ảnh. 
-. Nhấn Color chọn Washout để làm mờ ảnh.

-. Nhấn Text Wrapping Chọn Edit Wrap Point.
-. Nhấn Text Wrapping Chọn Behind Text để đặt chế độ ảnh làm nền cho văn bản. 
6. TẠO CHỮ THỤT ĐẦU DÒNG (DROP CAP)

-. Chọn chữ cái và vị trí muốn tạo Drop Cap. 

-. Nhấn Menu Format chọn Drop Cap.

-. Trong hộp Drop Cap chọn Dropped và kiểu Font trong hộp Font.

-. Nhấn OK để xác nhận.

* Lưu ý: Có thể điều chỉnh kích thước chữ thụt đầu dòng bằng cách kéo các điểm điều chỉnh trên hộp của chữ.

7. TẠO BÓNG NỀN CHO VĂN BẢN.
-. Chọn văn bản muốn tạo bóng nền.

-. Nhấn Menu Format chọn Borders and Shading, hộp thoại sẽ được mở ra.


[image: image40]3. Nhấn chuột vào Tab Shading chọn mầu và kiểu bóng nền. 

-. Nhấn OK để xác nhận.

* Lưu ý: Nếu muốn bỏ bóng nền cho văn bản ta chọn No Fill trong hộp chọn mầu.
PHẦN ÔN TẬP

CHƯƠNG TRÌNH SOẠN THẢO VĂN BẢN WORD
A- CÁC MENU VÀ CHỨC NĂNG THƯỜNG DÙNG NHẤT:

1- Menu File (Các lệnh về tập tin):

- New - Tạo tập tin mới 

- Open - Mở lại tập tin  đã có.

- Close - Đóng tập tin hiện có trên màn hình.

- Save - Ghi tập tin.

- Save As - Ghi tập tin ra ổ đĩa khác (ổ USB), ghi ra thư mục khác hoặc tạo bản sao với tên khác cho tập tin. 

- Page Setup - Định dạng trang (chỉnh lề, xoay trang, chọn khổ giấy).

- Print - Các lệnh về in tập tin.

3- Menu Insert (Chèn).

- Pages Number - Đánh số trang cho tập tin.

- Symbol: Chèn những ký tự lạ vào văn bản.

- Picture - Chèn tranh, các kiểu chữ nghệ thuật ... vào bảng.

- Text Box - Tạo hộp văn bản.

4- Menu Format (Các lệnh về định dạng).


- Font - Các lệnh về Font chữ (thay đổi kiểu chữ, cỡ chữ, thay đổi khoảng cách giữa các ký tự ...)


- Paragraph - Các lệnh đối với đoạn văn bản.


- Borders and Shading - Tạo viền cho bảng và tạo bóng nền.

- Drop Cap - Tạo chữ hoa thụt đầu dòng.

5- Menu Table (Các lệnh về bảng).


- Draw Table - Menu với tập hợp các lệnh về bảng (Căn đoạn văn bản vào giữa ô, thay đổi viền và nét viền bảng ...).


- Insert Table - Tạo bảng mới.


- Merge Cells - Chộn ô (Kết hợp ô).


- Split Cells – Chia ô (Chẻ ô).

B- CÁC LỆNH THƯỜNG DÙNG NHẤT TRONG CHƯƠNG TRÌNH SOẠN THẢO VĂN BẢN WORD.

I-  CÁC LỆNH VỀ VĂN BẢN VÀ TẬP TIN.

1- Tạo tập tin mới: Nhấn biểu tượng New [image: image41.bmp] (biểu tượng tờ giấy trắng).

2- Mở tập tin đã có: Nhấn biểu tượng Open [image: image42.bmp] (biểu tượng quyển sách mở).

3- Ghi tập tin: Nhấn biểu tượng Save [image: image43.bmp]  (biểu tượng đĩa mềm).

4- Ghi tập tin ra USB hoặc đĩa mềm: Nhấn Menu File\Save As\ Nhấn hộp xổ xuống Save In chọn My Compurter (chọn ổ USB)( Save.

5- In toàn bộ tập tin: Nhấn biểu tượng Print [image: image44.bmp] trên thanh công 
6- In tập tin với các lựa chọn khác: Nhấn Menu File\Print.(Xuất hiện hộp thoại với các lựa chọn in)

II- CÁC LỆNH DÙNG TRONG SOẠN THẢO:

1- Sao chép văn bản (Copy):

- Sao chép bằng cách kéo thả: Chọn nguồn\Nhấn Ctrl + nhấn giữ chuột kéo đến vị trí mới.

- Sao chép bằng công cụ: Chọn nguồn ( Nhấn biểu tượng Copy  [image: image45.bmp] (Ctrl+C) ( Di chuyển dấu chèn đến đích(Nhấn biểu tượng Paste [image: image46.bmp] (Ctrl+V).
2- Di chuyển văn bản:

- Di chuyển bằng cách kéo thả: Chọn nguồn\Nhấn giữ chuột kéo thả vào vị trí mới.

- Di chuyển bàng công cụ: Chọn nguồn\Nhấn biểu tượng Cut [image: image47.bmp] (Ctrl+X)\Di chuyển dấu chèn đến đích\Nhấn Paste [image: image48.bmp] (Ctrl+V).

3- Quay trở lại những thao tác trước: Nhấn Biểu tượng Undo trên thanh công cụ (Ctrl+Z). Quay trở lại lệnh Undo bằng cách nhấn biểu tượng Redo trên thanh công cụ (gần biểu tượng Undo).
III- ĐỊNH DẠNG VĂN BẢN:

1- In đậm, nghiêng và gạch chân văn bản: Các biểu tượng B (Ctrl+B), I (Ctrl+I), U (Ctrl+U). 

2-Thay đổi kiểu chữ, cỡ chữ: Hộp xổ xuống Font và Font Size trên thanh công cụ hoặc nhấn Menu Format\Font.

- Dùng Ctrl+] để tăng cỡ chữ lên 1 cỡ  (Point)

- Dùng Ctrl+[ để giảm cỡ chữ xuống 1 cỡ (Point).

4- Tạo chỉ số trên, chỉ số dưới: 

- Chỉ số trên: Ctrl+Shift+= .
- Chỉ số dưới: Ctrl+= .
5- Sao chép định dạng: Chọn nguồn\Nhấn biểu tượng Format Painter trên thanh công cụ (Hình cái chổi)\Nhấn giữ chuột quét lên văn bản cần sao chép.

6- Tạo bóng nền cho đoạn văn bản: Chọn văn bản\Nhấn Menu Format\Borders And Shading\Shading.

7- Tạo thụt đầu dòng và cách dòng tự động: Chọn Văn bản\Nhấn Menu Format\Paragraph\ Trong hộp xổ Special chọn First Line\Trong hộp Spacing chọn Before tăng lên khoảng 6pt - 8 pt.

8- Đánh số thứ tự tự động: Biểu tượng Numbering  [image: image49.bmp] trên thanh công cụ.
IV- CÁC LỆNH TẠO VĂN BẢN NGHỆ THUẬT.

1- Khởi động các công cụ vẽ: Nhấn biểu tượng Drawing trên thanh công cụ. Khi được khởi động các thanh công cụ vẽ hiển thị dưới cuối màn hình.

2- Chèn các ký tự đặc biệt: Nhấn Menu Insert\Symbol.

3- Chèn hình ảnh: Nhấn Menu Insert\Picture\Clip Art.

4- Tạo các kiểu chữ nghệ thuật: Nhấn Menu Insert\Picture\ WordArt.

5- Tạo chữ hoa thụt đầu dòng (Drop Cap): Nhấn Menu Insert\Drop Cap.

6- Tạo hộp văn bản (Text Box): Nhấn Menu Insert\Text Box.
V- CÁC LỆNH VỀ BẢNG.

1- Tạo bảng mới: Nhấn biểu tượng Insert Table trên thanh công cụ.

2- Chèn thêm một dòng vào bảng: Nhấn Menu Table chọn Insert Rows.

3- Chèn thêm cột vào bảng: Chọn cả cột\Nhấn menu Table\Insert Columns.

4- Xoá dòng hoặc cột ở bảng: Chọn dòng hoặc cột\Nhấn biểu tượng Cut trên thanh công cụ. Nếu muốn xoá dữ liệu, giữ nguyên dòng hoặc cột ta bôi đen dữ liệu muốn xoá nhấn phím Delete trên bàn phím.

5- Kết hợp các ô của bảng: Chọn các ô cần kết hợp\Nhấn Menu Table\Merge Cells.

6- Chẻ các ô: Chọn ô cần chẻ\Nhấn Menu Table\Split Cells.

7- Tạo và thay đổi đường viền cho bảng: Chọn bảng\Nhấn Menu Format\Borders and Shading\Borders.

8- Thay đổi độ rộng dòng bằng Menu: Chọn dòng\Nhấn Menu Format\Paragraph\Trong hộp Spacing tăng cả Before và After lên khoảng 3 pt.

9- Căn giữa khoảng cách trên, dưới đối với văn bản trong ô: Chọn văn bản\Nhấn Menu Table\Draw Table\Chọn biểu tượng căn giữa Centre Vertically.

VI- CĂN CHỈNH LỀ VÀ IN TẬP TIN:

1- Xem trước trang in: Biểu tượng Print Preview (Biểu tượng kính lúp).

2- Chọn khổ giấy ngang: Nhấn Menu File\Page Setup\Page Size\Landscape.

3- Chỉnh lề cho tập tin: Nhấn Menu File\Page Setup\Margins. 

4- Đánh số trang: Nhấn Menu Insert\Page Numbers\Chọn vị trí đánh số trang hộp Position: Top of Page (Header): đánh ở đầu trang; Bottom of Page (Footer): đánh ở chân trang\Chọn vị trí sắp xếp số thứ tự hộp Alignment: Left: Góc trái; Centre: ở giữa; Right: Góc phải. - Bỏ chọn trong hộp Show number on first page để không đánh số trang ở trang đầu tiên của văn bản.

5- Đánh số trang tiếp theo: Nhấn Menu Insert\Page Numbers\Chọn vị trí đánh số trang trong các hộp xổ Position và Alignment\Format\Gõ số trang muốn đánh tiếp vào hộp Start at.

6- In văn bản: Muốn in toàn bộ văn bản nhấn biểu tượng Print trên thanh công cụ (Biểu tượng máy in).

- In văn bản với các lựa chọn khác: Nhấn Menu File\Print.
Bµi 1: b¶ng tÝnh ®iÖn tö Excel 2003

Excel 2003 lµ mét phÇn mÒm n»m trong bé Office 2003 cña Microsoft ch¹y trªn m«i tr­êng Windows cã nhiÒu ®iÓm gièng víi Word 2003.


Bé Office 2003 bao gåm Word 2003 (So¹n th¶o v¨n b¶n), Excel 2003 (B¶ng tÝnh ®iÖn tö), Access 2003 (Qu¶n trÞ c¬ së d÷ liÖu), Power Point 2003 (Gi¸o ¸n ®iÖn tö), Outlook 2003 (Th­ ®iÖn tö), Pront Page (LËp tr×nh Web).
1) Khëi ®éng Excel
Trªn nÒn mµn h×nh nÒn ®Çu tiªn (Desktop)
C1: --> Start --> Program --> Microsoft Excel…
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C2: Nh¸y ®óp (Double click)  vµo biÓu 
[image: image51.wmf]Microsoft Excel.lnk

 t­îng Microsoft Excel cña ch­¬ng tr×nh 

2) Tho¸t khái Excel

C1: --> File --> Close (Exit)

C2: --> Click vµo biÓu t­îng ch÷ X cã mµu ®á ë gãc ph¶i mµn h×nh

C3: -->  NhÊn tæ hîp phÝm Alt + F4


* L­u ý: Trong tr­êng hîp b¹n tho¸t khái Excel mµ ch­a l­u File hoÆc cã nh÷ng thay ®æi trªn b¶ng tÝnh mµ ta ch­a l­u l¹i th× m¸y tÝnh sÏ ®­a ra th«ng b¸o nh­ sau:
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3) Mµn h×nh lµm viÖc cña Excel
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Tªn file, kiÓu file cña b¶ng tÝnh.


Thanh thùc ®¬n (Menu).



Côm nót cùc tiÓu, phãng to, thu nhá, ®ãng cöa sæ l¹i.



Thanh c«ng cô.


Thanh c«ng thøc.



Thanh cuèn däc, ngang cña cöa sæ lµm viÖc.

       
Thanh tr¹ng th¸i c¸c b¶ng tÝnh (Sheet). 


C¸c cét ®­îc ®¸nh theo vÇn ch÷ c¸i 256 cét

C¸c dßng ®­îc ®¸nh theo sè tõ 1-> 65536

* L­u ý:     C¸c thao t¸c so¹n th¶o, c¾t, d¸n, sao chÐp t­¬ng tù nh­ 

trong Word.
* Thanh thùc ®¬n ( menu )
[image: image54.png]B3 Microsoft Excel - Book1 =12l
DBESESRY 4 BA-J o-o- @z -4 lduw -0,
e <z -|nzu| Hs %, [E20A-.

AEXCD E F G | H T 1

0l

Fle Edt Vew Inwet Fomat ook Data Window Help Tvpequssion for el

21 -
i< » vil\sheet1 (Shestz { Shests K| Bl

Ready M





	Nhãm lÖnh vÒ tÖp
	Nhãm lÖnh s¹on th¶o
	Nhãm lÖnh mµn h×nh lµm viÖc
	Nhãm lÖnh chÌn c¸c ®èi t­îng
	Nhãm lÖnh ®Þnh d¹ng
	Nhãm lÖnh vÒ c«ng cô tiÖn Ých
	Nhãm lÖnh vÒ d÷ liÖu
	Nhãm lÖnh vÒ cöa sæ
	Nhãm lÖnh vÒ chî gióp


Bµi 2: c¸c thao t¸c ®Þnh d¹ng trong  Excel
1. C¸c thao t¸c chän b¶ng tÝnh


- Chän dßng trong b¶ng tÝnh ®­a chuét ra ®Çu dßng n¬i cã c¸c sè tõ 1,2…65536  dßng khi ®ã chuét biÕn thµnh h×nh mòi tªn n»m ngang b¹n bÊm chuét vµ rª (drag) ®Õn hÕt dßng cÇn chän.


-  Chän cét trong b¶ng tÝnh ®­a chuét ra ®Çu cét cÇn chän cã c¸c ch÷ c¸i in hoa tõ A,B…AA, AB…(cã 256 cét) khi ®ã chuét biÕn thµnh h×nh mòi tªn n»m däc b¹n bÊm chuét vµ rª (drag) ®Õn hÕt cét cÇn chän.


- Chän c¶ b¶ng tÝnh…. Click mouse nh­ h×nh vÏ.
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2. §Þnh d¹ng cho d÷ liÖu kiÓu sè

- Chän vïng d÷ liÖu cÇn ®Þnh d¹ng --> Format --> Cell…

    VD: §Þnh d¹ng kiÓu sè víi ch÷ sè ch÷ sè phÇn thËp ph©n lµ 2 ch÷ sè
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ë ®©y b¹n còng cã thÓ ®Þnh d¹ng kiÓu hiÓn thÞ kh¸c nh­ ngµy, giê thêi gian, chän kiÓu quay ch÷, Font ch÷, ®­êng viÒn…

3. KÎ khung cho b¶ng tÝnh 

Trong Excel b¹n muèn kÎ khung cho b¶ng tÝnh ta lµm nh­ sau:

Chän vïng d÷ liÖu cÇn kÎ khung --> Format -->Cells…--> Border
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ë hép tho¹i nµy b¹n chän c¸c kiÓu ®­êng kÎ mµ b¹n muèn vµ chän kÎ ®­êng viÒn hay c¶ v¨n b¶n tuú yªu cÇu cña b¹n chän xong --> OK

4. Chén «, chén cét

B¹n b«i ®en vïng cÇn chén « hoÆc chén cét råi lµm nh­ h×nh vÏ sau:
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5. §Þa chØ trong Excel

* §Þa chØ t­¬ng ®èi (Relative Address) §Þa chØ t­¬ng ®èi ®­îc x¸c ®Þnh ®¬n thuÇn chØ lµ to¹ ®é cét vµ dßng nh­ A1; D3. NÕu ®Þa chØ nµy ghi trong « c«ng thøc, khi sao chÐp c«ng thøc tíi mét vÞ trÝ kh¸c ®Þa chØ tù ®éng thay ®æi theo b¶o ®¶m mèi quan hÖ t­¬ng ®èi gi÷a « nguån cã c«ng thøc vµ « c«ng thøc ®­îc sao chÐp.

- VÝ dô: NÕu trong « C5 ®Æt c«ng thøc '=A5 + B5'


   khi sao chÐp c«ng thøc sang « C6 c«ng thøc sÏ lµ '=A6 + B6'


   khi sao chÐp c«ng thøc sang « D5 c«ng thøc sÏ lµ '=B5 + C5'


* §Þa chØ tuyÖt ®èi (Absolute Address) §Þa chØ tuyÖt ®èi ®­îc ghi x¸c ®Þnh bëi dÊu ($) tr­íc sè hiÒu cã dßng vµ cét nh­ $A$1. To¹ ®é cña « ghi trong c«ng thøc sÏ kh«ng thay ®æi khi ta sao chÐp tíi bÊt k× vÞ trÝ nµo.

VÝ dô: NÕu trong « C5 ®Æt c«ng thøc ''=$A$5 + $B$5''

khi sao chÐp c«ng thøc sang « C6 c«ng thøc vÉn lµ ''=$A$5 + $B$5''

6. NhËp d÷ liÖu (Data) trong Excel

- Khi cÇn xuèng dßng trong mét « b¹n gâ Alt + Enter


- D÷ liÖu d¹ng ngµy ngÇm ®Þnh lµ MM/DD/YY


- Trong chÕ ®é ngÇm ®Þnh Excel dïng dÊu " . " lµm dÊu ng¨n c¸ch gi÷a phÇn nguyªn vµ phÇn thËp ph©n.


- X©u kÝ tù ®­îc ®Æt trong dÊu " "



VD: = if(B2>=5,"§¹t","kh«ng xÕp lo¹i")
7. ChØnh söa tr­íc khi in Ên


Nh¸y chuét vµo --> File --> Print preview ë ®©y b¹n cã thÓ xem nh­ trong Word tr­íc khi in b¹n còng cã thÓ chØnh l¹i theo ý muèn.

VÝ dô: B¹n chØnh lÒ cho v¨n b¶n --> File --> Print preview --> Margins khi ®ã sÏ biÕn thµnh c¸c ®­êng kÎ nh­ h×nh vÏ ë ®©y b¹n cã thÓ thay ®æi ®é réng hÑp tuú ý.
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 Bµi 3: c¸c hµm trong  Excel
1. D¹ng c«ng thøc tæng qu¸t cña hµm


Hµm lµ c¸c c«ng thøc ®Þnh s½n nh»m thùc hiÖn c¸c yªu cÇu tÝnh to¸n. Trªn « thùc hiÖn hµm cho kÕt qu¶ lµ gi¸ trÞ sè, chuçi, hoÆc c¸c th«ng b¸o lçi. Trong Excel cã trªn 300 hµm ®Þnh s½n ®­îc ph©n theo nhãm.

D¹ng c«ng thøc tæng qu¸t cña hµm nh­ sau:


=Tªn hµm(bt logic1, bt logic2…, bt logic n) 


Tªn hµm sö dông theo quy ­íc cña Excel


§èi sè: ®a phÇn lµ c¸c hµm trong Excel sö dông ®èi sè, ®èi sè cã thÓ lµ c¸c gi¸ trÞ sè, chuçi, to¹ ®é «, c«ng thøc hoÆc c¸c hµm kh¸c lång nhau.

2. C¸ch nhËp hµm


§Æt con trá ë n¬i cÇn cã kÕt qu¶ - Gâ tªn hµm tõ bµn phÝm


- Insert --> Function…XuÊt hiÖn h«p tho¹i b¹n chän tªn hµm ë « 

Select a category
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Sau ®ã b¹n nhËp vµo biÓu thøc biÓu thøc logic1,  biÓu thøc logÝc2…
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Cuèi cïng b¹n chän OK

3. C¸c hµm th«ng dông trong Excel
(1) Hµm AVERAGE(danh s¸ch gi¸ trÞ sè). Hµm cho gi¸ trÞ trung b×nh céng cña danh s¸ch c¸c gi¸ trÞ sè.


VÝ dô muèn tÝnh trung b×nh céng cña c¸c « B1, B2, B3 cã c¸c gi¸ trÞ lÇn l­ît lµ 5, 4, 6 kÕt qu¶ ®Æt ë « B4 ta cã c«ng thøc nh­ sau:


=AVERAGE(B1,B2,B3) th× kÕt qu¶ ®­îc trong « B4 lµ 5.

(2) Hµm MAX(danh s¸ch c¸c gi¸ trÞ sè). Hµm cho gi¸ trÞ lín nhÊt trong danh s¸ch c¸c gi¸ trÞ sè.


VÝ dô muèn t×m gi¸ trÞ lín nhÊt cña c¸c « B1, B2, B3 cã c¸c gi¸ trÞ lÇn l­ît lµ 5, 9, 6 kÕt qu¶ ®Æt ë « B4 ta cã c«ng thøc nh­ sau:


=MAX(B1:B3) th× kÕt qu¶ ®­îc trong « B4 cã gi¸ trÞ lµ 9.

(3) Hµm MIN(danh s¸ch c¸c gi¸ trÞ sè). Hµm cho gi¸ trÞ nhá nhÊt trong danh s¸ch c¸c gi¸ trÞ sè.


VÝ dô muèn t×m gi¸ trÞ nhá nhÊt cña c¸c « B1, B2, B3 cã c¸c gi¸ trÞ lÇn l­ît lµ 5, 9, 6 kÕt qu¶ ®Æt ë « B4 ta cã c«ng thøc nh­ sau:

=MIN(B1:B3) th× kÕt qu¶ ®­îc trong « B4 cã gi¸ trÞ lµ 5.

(3) Hµm SUM(danh s¸ch c¸c gi¸ trÞ sè). Hµm cho gi¸ trÞ tæng cña danh s¸ch c¸c gi¸ trÞ sè.


VÝ dô muèn t×m tæng cña c¸c « B1, B2, B3 cã c¸c gi¸ trÞ lÇn l­ît lµ 5, 9, 6 kÕt qu¶ ®Æt ë « B4 ta cã c«ng thøc nh­ sau:


= SUM(B1:B3) th× kÕt qu¶ ®­îc trong « B4 cã gi¸ trÞ lµ 20.

(4) Hµm AND(bt logic1, bt logic2,…). Hµm tr¶ vÒ gi¸ trÞ ®óng (TRUE) nÕu tÊt c¶ c¸c biÓu thøc logic ®Òu cho gi¸ trÞ ®óng; tr¶ vÒ gi¸ trÞ sai (FALSE) khi mét hoÆc nhiÒu biÓu thøc logic nhËn gi¸ trÞ sai

VD


= AND(TRUE, TRUE) kÕt qu¶ lµ TRUE


= AND(TRUE, FALSE) kÕt qu¶ lµ FALSE
(5) Hµm OR (bt logic1, bt logic2,…).Hµm cho gi¸ trÞ ®óng (TRUE) nÕu Ýt nhÊt mét trong c¸c biÓu thøc logic cho gi¸ trÞ ®óng; tr¶ vÒ gi¸ trÞ sai (FALSE) nÕu tÊt c¶ c¸c biÓu thøc logic nhËn gi¸ trÞ sai

VD 


= OR(1+1=2,2+2=5) cho kÕt qu¶ lµ TRUE


= OR(1+1=3,2+2=5) cho kÕt qu¶ lµ FALSE

(6) Hµm IF(bt logic, gi¸ trÞ 1, gi¸ trÞ 2) Hµm tr¶ vÒ gi¸ trÞ 1 nÕu biÓu thøc logÝc ®óng tr¶ vÒ gi¸ trÞ 2 nÕu biÓu thøc logic sai.

VD 


=IF(B5>=5,"§¹t","Kh«ng xÕp lo¹i")

* L­u ý: C¸c gi¸ trÞ cã thÓ lµ c¸c biÓu thøc logic lång nhau
	 
	A
	B
	C
	D
	E
	F
	 G
	 H
	 I
	 J
	 L
	 M

	1
	B¶ng ®iÓm häc k× I
	 
	 
	 
	 
	 
	 
	 
	 
	 

	2
	M«n: To¸n
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	3
	Líp:….
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	4
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	5
	STT
	Hä vµ tªn
	Ngµy sinh
	Giíi tÝnh
	HÖ sè 1
	HÖ sè 2
	HÖ sè 3
	TBM
HK
	XL 
	Ghi chó

	6
	
	
	
	
	M
	15
	1T 
	HK 
	
	
	

	7
	
	
	
	
	
	
	
	
	
	
	

	8
	1
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	9
	2
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	10
	3
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	11
	4
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	12
	5
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	13
	6
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	14
	7
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 


Bµi tËp 1: T¹o mét b¶ng tÝnh kÕt qu¶ ®iÓm kiÓm tra häc k× cña häc sinh trong mét líp cã d¹ng nh­ sau:


B¹n h·y tù nhËp vµo hä tªn häc sinh, ®iÓm cña líp m×nh råi dùa vµo c¸c hµm ®· häc trªn h·y nhËp vµo c«ng thøc tÝnh TBMHK ®Ó m¸y tinh tÝnh cho b¹n.

Gîi ý: Trong tr­êng hîp b¹n nhËp sè lÇn kiÓm tra nh­ trªn th× c«ng thøc ë « ®Çu sÏ lµ = (E8+F8+G8*2+H8*2+I8*3) /9

T­¬ng tù nh­ vËy b¹n copy c«ng thøc ®Õn « HS thø 2 b»ng c¸ch b¹n ®­a chuét xuèng gãc ph¶i phÝa d­íi « c«ng thøc khi chuét biÕn thµnh biÓu t­îng + th× b¹n bÊm chuét vµ rª chuét ®Õn HS cuèi cïng m¸y tÝnh sÏ tù ®éng copy ë d¹ng ®Þa chØ t­¬ng ®èi

Bµi tËp 2:  Víi b¶ng tÝnh ë bµi 1 h·y nhËp vµo c¸c hµm ®· häc trªn h·y nhËp vµo c«ng thøc tÝnh ®Ó m¸y tÝnh xÕp lo¹i cho b¹n c¸c lo¹i Giái, kh¸, TB, YÕu……..:
Bµi tËp Excel

Bµi 1


B¸o c¸o s¶n l­îng 6 th¸ng ®Çu n¨m
	stt
	Tªn sp
	Th 1
	Th2
	Th3
	Th4
	Th5
	Th6
	Tæng

	1
	Tñ t­êng
	230
	241
	113
	546
	125
	256
	

	2
	Tñ ®øng
	250
	120
	119
	546
	145
	235
	

	3
	Tñ v¶i
	231
	220
	250
	532
	135
	423
	

	4
	Bµn v¨n phßng
	120
	150
	142
	471
	120
	254
	

	5
	Bµn vi tÝnh
	451
	140
	132
	451
	621
	123
	

	6
	Bãng ®Ìn trÇn
	263
	230
	152
	150
	256
	241
	

	7
	Bãng ®Ìn dµi
	121
	263
	123
	125
	231
	254
	


Yªu cÇu :

· Thªm  cét Tæng quý 1 vµ tæng quý 2 vµo sau cét th3, vµ th6. sau ®ã tÝnh tæng

     s¶n l­îng tõng quý

· Cét tæng lµ tæng s¶n l­îng 6 th¸ng

· TÝnh tæng céng sè l­îng cña c¸c s¶n phÈm cña tõng th¸ng. thªm mét lo¹i s¶n 

     phÈm lµ 

                 Tñ tµi liÖu vµo sau s¶n phÈm tñ ®øng, tù cho sè liÖu

· TÝnh tæng c¸c lo¹i tñ

· Trang trÝ kÎ b¶ng cho b¶ng tÝnh

· Ghi vµo th­ môc cña m×nh víi tªn bµi 1.xls
Bµi 2

B¶ng l­¬ng
	stt
	Hä vµ tªn
	Chøc vô
	Lcb
	Ngµy c«ng
	L­¬ng
	T¹m øng
	Cßn l¹i

	1
	 NguyÔn v¨n Ba
	Nv
	1500
	24
	
	
	

	2
	TrÇn v¨n §«ng
	Tp
	2100
	25
	
	
	

	3
	Ph¹m v¨n B¸ch
	Pp
	2100
	26
	
	
	

	4
	NguyÔn thÞ B×nh
	Bv
	1500
	24
	
	
	

	5
	Vò thÞ kim Anh
	Nv
	1500
	26
	
	
	

	6
	TrÇn nguyÖt Hµ
	Nv
	1500
	25
	
	
	

	7
	NguyÔn thÞ Thuû
	Nv
	1500
	24
	
	
	

	8
	Hoµng anh Tó
	Pg®
	2900
	23
	
	
	

	9
	TrÞnh h¶i Anh
	Tp
	2100
	24
	
	
	

	10
	Ph¹m tiÕn Th­
	G®
	2900
	27
	
	
	


Yªu cÇu : 

· L­¬ng = 650.000*ngµy c«ng

· T¹m øng = 2/3 l­¬ng th¸ng víi nh÷ng ng­êi lµ g® hoÆc pg®, cßn l¹i t¹m øng1/2 l­¬ng th¸ng

            Lµm trßn ®Õn hµng ngh×n ®ång b»ng hµm round

· Cßn lÜnh = l­¬ng – t¹m øng

· Ghi b¶ng tÝnh víi tªn l­¬ng.xls

Bµi 3

B¶ng l­¬ng nh©n viªn

	stt
	Tªn
	Phßng
	Sè con
	Møc l­¬ng
	Lo¹i kt
	Pcg®
	Th­ëng
	T¹m øng
	Tæng lÜnh

	1
	Anh
	Vp
	2
	34000
	A
	
	
	
	

	2
	B×nh
	Kt
	1
	35000
	B
	
	
	
	

	3
	C­êng
	Kt
	1
	45000
	A
	
	
	
	

	4
	Duy
	Kd
	1
	50000
	C
	
	
	
	

	5
	Giang
	Kt
	3
	55000
	A
	
	
	
	

	6
	HiÒn
	Vp
	2
	35000
	C
	
	
	
	

	7
	Hoa
	Kd
	1
	20000
	A
	
	
	
	

	8
	Kiªn
	Bv
	3
	40000
	C
	
	
	
	

	9
	Lan
	Vp
	3
	50000
	A
	
	
	
	

	10
	Lª
	Kt
	2
	65000
	B
	
	
	
	

	11
	Léc
	Kt
	1
	45000
	A
	
	
	
	

	12
	Nam
	Kd
	2
	30000
	C
	
	
	
	

	13
	Oanh
	Kt
	1
	40000
	A
	
	
	
	

	14
	Ph­¬ng
	vp
	1
	35000
	A
	
	
	
	


Yªu cÇu : 

· TÝnh PCG§ theo quy t¾c sau:

NÕu sè con <= 1 th× PCG§ lµ 150000

NÕu sè con >1 thÞ PCG§ lµ 20000

· Cét th­ëng ®­îc tÝnh:

NÕu lo¹i KT lµ A: th­ëng 50000

NÕu lo¹i KT lµ B : th­ëng 25000

NÕu lo¹i KT lµ C : th­ëng 10000

· Cét t¹m øng ®­îc tÝnh:

NÕu ë phßng KD : t¹m øng 50% l­¬ng

NÕu ë phßng KT hoÆc VP : t¹m øng 40% l­¬ng

NÕu ë phßng BV vµ cã sè con >1 : t¹m øng 30% l­¬ng

Cßn l¹i kh«ng t¹m øng

· Tæng lÜnh = l­¬ng+th­ëng-t¹m øng

Bµi 4

Doanh sè b¸n hµng th¸ng

	stt
	MÆt hµng
	®¬n vÞ
	®¬n gi¸ chôc
	®¬n gi¸ lÎ
	Sè l­îng
	Sè chôc
	Sè lÎ
	Thµnh tiÒn

	1
	Bét giÆt
	Tói
	70000
	7200
	46
	
	
	

	2
	Kem p/s
	èng
	34000
	3600
	15
	
	
	

	3
	Xµ b«ng lux
	B¸nh
	40000
	4100
	23
	
	
	

	4
	DÇu kao
	Chai
	120000
	12500
	9
	
	
	

	5
	H­¬ng muçi
	Hép
	33000
	3500
	36
	
	
	


Yªu cÇu:

a. TÝnh sè chôc: lÊy phÇn nguyªn hµng chôc cña sè l­îng

b. TÝnh sè lÎ: lÊy phÇn d­ cña sè l­îng

c. TÝnh thµnh tiÒn = (sè chôc * ®¬n gi¸ chôc) + (sè lÎ * ®¬n gi¸ lÎ)

Bµi 5
	C«ng ty du lÞch abc
	B¶ng kª tiÒn thuª phßng

	Kh¸ch s¹n v× sao
	

	
	

	Tªn kh¸ch
	Phßng thuª
	Ngµy
	Sè ngµy thuª
	§¬n gi¸
	Sè ngµy tÝnh ®¬n gi¸
	TiÒn tr¶

	
	
	§Õn
	§i
	
	
	100%
	95%
	90%
	

	Jack
	A01
	15/01/2005
	01/04/2005
	
	
	
	
	
	

	Richard
	B01
	26/02/2005
	05/04/2005
	
	
	
	
	
	

	Jane
	B02
	15/03/2005
	05/04/2005
	
	
	
	
	
	

	Turner
	A02
	16/03/2005
	10/04/2005
	
	
	
	
	
	

	Tom
	C05
	18/03/2005
	15/04/2005
	
	
	
	
	
	

	Jonh
	D01
	26/03/2005
	20/04/2005
	
	
	
	
	
	

	Robert
	A03
	26/03/2005
	26/04/2005
	
	
	
	
	
	


Yªu cÇu:

a. tÝnh sè ngµy thuª = ngµy ®i – ngµy ®Õn

b. tÝnh ®¬n gi¸ nh­ sau: nÕu phßng thuéc lo¹i A th× ®¬n gi¸ lµ 100000, nÕu lµ B th× 80000, nÕu C th× 60000 cßn l¹i lµ 50000.

c. tÝnh c¸c cét  sè ngµy tÝnh ®¬n gi¸ ( ph©n bæ sè ngµy theo tõng cét ) nh­ sau:

· 10 ngµy ë ®Çu tiªn tÝnh 100% cña ®¬n gi¸

· 15 ngµy tiÕp theo tÝnh 95% cña ®¬n gi¸

· Nh÷ng ngµy kÕ tiÕp chØ tÝnh 90% cña ®¬n gi¸

d. TÝnh tiÒn tr¶ = tæng (sè ngµy  ë cña c¸c cét ®· ph©n bæ * % cña ®¬n gi¸)

Bµi 6


B¶ng l­¬ng nh©n viªn

Th¸ng 8 n¨m 2009
	STT
	Hä vµ tªn
	Chøc vô
	LCB
	NC
	PCCV
	L­¬ng
	T¹m øng
	Cßn l¹i

	
	NguyÔn thÞ Hång
	TP
	29000
	25
	
	
	
	

	
	Lª Thu thuú
	NV
	25000
	24
	
	
	
	

	
	NguyÔn thÞ Thuû
	Pp
	29000
	26
	
	
	
	

	
	NguyÔn ThÞ H»ng
	Kt
	28000
	25
	
	
	
	

	
	TrÇn mai Quý
	G®
	35000
	28
	
	
	
	

	
	Bïi BÝch Ph­îng
	Tp
	29000
	25
	
	
	
	

	
	Ph¹m Thu H­¬ng
	Pg®
	35000
	29
	
	
	
	

	
	TrÇn ®øc Thµnh
	Nv
	25000
	25
	
	
	
	

	
	Ph¹m minh C­¬ng
	Bv
	20000
	28
	
	
	
	

	
	Ph¹m thÞ HuÖ
	Nv
	25000
	30
	
	
	
	

	
	Lª ®øc Linh
	Nv
	25000
	26
	
	
	
	

	
	TrÇn minh Khiªm
	Pp
	29000
	22
	
	
	
	

	
	Bïi tiÕn L­¬ng
	Nv
	25000
	27
	
	
	
	

	
	§ç thu Trang
	Nv
	25000
	25
	
	
	
	

	
	TrÇn kim Quyªn
	Kt
	28000
	26
	
	
	
	

	
	Tæng céng
	
	
	
	
	
	
	

	
	B×nh qu©n
	
	
	
	
	
	
	

	
	Cao nhÊt
	
	
	
	
	
	
	

	
	ThÊp nhÊt
	
	
	
	
	
	
	


Yªu cÇu:

1- NhËp sè thø tù

2- TÝnh PCCV theo yªu cÇu sau:

· NÕu chøc vô lµ “G§” th× PCCV lµ 150000

· NÕu chøc vô lµ “PG§” hoÆc “TP”  th× PCCV lµ 100000

· NÕu chøc vô lµ “PP” hoÆc “KT” th× PCCV lµ 80.000

· NÕu chøc vô lµ “NV” vµ cã ngµy c«ng >=25  th× PCCV lµ 50.000

· Cßn l¹i kh«ng cã PCCV

3- L­¬ng ®­îc tÝnh b»ng L­¬ng c¨n b¶n * Ngµy c«ng; nh­ng nÕu sè ngµy c«ng lµm viÖc > 24 ngµy th× mçi ngµy lµm viÖc v­ît trªn 24 ngµy ®ã ®­îc tÝnh gÊp ®«i.

4- T¹m øng tÝnh b»ng 50% cña tæng sè (l­¬ng + pccv) nh­ng kh«ng ®­îc qu¸ 300000

5- Cßn l¹i = (pccv +l­¬ng)- t¹m øng

6- tÝnh tæng céng, b×nh qu©n, cao nhÊt, thÊp nhÊt theo c¸c cét Ngµy c«ng, Pccv, l­¬ng

Bµi 7
	L­¬ng CB
	650000

	Sè ngµy Q§
	24


	Stt
	Hä vµ tªn
	Giíi tÝnh
	Gia c¶nh
	Hsl
	Ngµy c«ng
	XÕp lo¹i
	Phô cÊp
	Th­ëng 
	T¹m øng
	Thùc lÜnh

	
	NguyÔn V¨n Ba
	1
	1
	4.1
	25
	
	
	
	
	

	
	TrÞnh thÞ hoa
	0
	2
	2.8
	26
	
	
	
	400000
	

	
	Hoµng m¹nh tïng
	1
	0
	3.86
	24
	
	
	
	
	

	
	TrÇn v¨n m¹nh
	1
	3
	3.5
	23
	
	
	
	
	

	
	NguyÔn ®øc toµn
	1
	2
	5.5
	22
	
	
	
	
	

	
	Ph¹m trÇn ph­¬ng
	1
	1
	2.78
	24
	
	
	
	150000
	

	
	Lª thanh lan
	0
	2
	3.6
	21
	
	
	
	
	

	
	Hµn thu h­êng
	0
	0
	1.92
	20
	
	
	
	
	

	
	Lý tiÓu hoa
	0
	0
	3.6
	19
	
	
	
	200000
	

	
	Phan thanh th¶o
	0
	1
	3.25
	28
	
	
	
	
	


Chó ý: Cét giíi tÝnh 0: N÷, 1: Nam

Yªu cÇu:

1- XÕp lo¹i: nÕu ngµy c«ng >= 24 th× lo¹i A, nÕu ngµy c«ng >=22 vµ <24 th× lo¹i B cßn l¹i lµ lo¹i C

2- Phô cÊp: NÕu gia c¶nh cã tõ hai con trë lªn th× phô cÊp lµ 280000, nÕu lµ n÷ vµ gia c¶nh kh«ng cã con hoÆc cã 1 con th× phô cÊp lµ 220000, cßn l¹i kh«ng cã phô cÊp

3- Th­ëng: lo¹i A th× th­ëng 200000, lo¹i B kh«ng cã, lo¹i C th× ph¹t 100000 (ph¹t ®Ó dÊu ©m)

Chó ý: lo¹i B kh«ng th­ëng kh«ng ®­îc ®Ó sè mµ ph¶i ®Ó dÊu “”

4- Thùc lÜnh = (l­¬ng c¬ b¶n * hÖ sè l­¬ng *ngµy c«ng)/sè ngµy Q§ + th­ëng +phô cÊp – t¹m øng

Bµi 8
B¶ng ®iÓm häc kú I – 2010
	STT
	Tªn
	Giíi tÝnh
	N¨m sinh
	To¸n
	V¨n
	N.ng÷
	§TB

	1
	Anh
	Nam
	1971
	7
	8
	8
	

	2
	B×nh
	Nam
	1975
	7
	5
	9
	

	3
	C­êng
	Nam
	1973
	5
	6
	5
	

	4
	Duy
	N÷
	1972
	6
	7
	6
	

	5
	Giang
	Nam
	1970
	8
	8
	7
	

	6
	Ph­¬ng
	Nam
	1968
	8
	8
	5
	

	7
	Hoa
	N÷
	1968
	7
	5
	8
	

	8
	Kiªn
	Nam
	1966
	6
	4
	9
	

	9
	Lan
	N÷
	1965
	5
	8
	7
	

	10
	Lª
	N÷
	1959
	8
	6
	6
	

	11
	LÖ
	N÷
	1961
	6
	8
	8
	

	12
	C­êng
	Nam
	1974
	8
	7
	6
	

	13
	Oanh
	N÷
	1976
	9
	8
	8
	

	14
	Ph­¬ng
	N÷
	1976
	7
	9
	9
	

	15
	QuÕ
	nam
	1975
	5
	6
	7
	


Yªu cÇu : 

· tÝnh ®iÓm trung b×nh cho c¸c häc sinh

· XÕp h¹ng cho tõng häc sinh theo thø tù gi¶m dÇn(thªm cét xÕp h¹ng)

· s¾p xÕp l¹i CSDL theo cét tªn theo thø tù t¨ng dÇn. NÕu trïng th× s¾p xÕp n¨m sinh theo thø tù gi¶m sau ®ã coppy kÕt qu¶ s¾p xÕp sang 1 sheet míi, ®Æt tªn lµ SAPXEP1

· s¾p xÕp l¹i  CSDL theo cét to¸n theo thø tù t¨ng dÇn, nÕu trïng th× s¾p xÕp DTB theo thø tù gi¶m dÇn

Bµi 1: C¸c thao t¸c c¬ b¶n PhÇn mÒm tr×nh chiÕu
Microsoft Office PowerPoint 2003

1. Khëi ®éng vµ tho¸t PowerPoint 2003

a. Khëi ®éng PowerPoint 2003

c1:-->Start -->Program 


-->Microsoft Office

--> Microsoft Office PowerPoint 2003

c2: Nh¸y ®óp vµo biÓu t­îng

Microsoft Office PowerPoint 2003

Trªn nÒn mµn h×nh (Decktop)

b. Tho¸t PowerPoint 2003

c1: --> File --> exit (Close)

c2: Nh¸y chuét vµo biÓu t­îng

ch÷  X  mµu ®á ë gãc ph¶i phÝa

trªn mµn h×nh

2. Mµn h×nh Microsoft Office PowerPoint 2003
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a. Thanh thùc ®¬n (Menu)
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Cac thanh cong cu

Thanh Standard (noi chita cdc biéu tuong mdy in, ghi,
sao chéplién keét, bng....)

T BY R Y I L =R T Y
Thanh Formating (Noi chifa cdc biéu tugng Phong chit, mau chi,
kiéu chi, ¢d chi....).

co-szus[EES A A | oo tense )
Thanh Menu (chifa céc menu chon 1énh)
) e £t vew Iwert Famat Iook Sideshow Wndow Heb
Thanh Drawing : Chta céc niit cong cu dé v& hinh.

oun - [] Aoses \ N\ OO A G @A D2 A ]

Néu cdc thanh ndy ma mit ta 6 thé chon vio View->Toolbars-> Standard
(Formating) dé hién thi.

Ready 4 q 3/ ¥~ b DO 0 63.06% m

stat B E € \J





b. Thanh c«ng cô chuÈn Standard
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Cac thanh cong cu

Thanh Standard (noi chita cdc biéu tuong mdy in, ghi,
sao chéplién keét, bng....)

T BY R Y I L =R T Y
Thanh Formating (Noi chifa cdc biéu tugng Phong chit, mau chi,
kiéu chi, ¢d chi....).

co-szus[EES A A | oo tense )
Thanh Menu (chifa céc menu chon 1énh)
) e £t vew Iwert Famat Iook Sideshow Wndow Heb
Thanh Drawing : Chta céc niit cong cu dé v& hinh.

oun - [] Aoses \ N\ OO A G @A D2 A ]

Néu cdc thanh ndy ma mit ta 6 thé chon vio View->Toolbars-> Standard
(Formating) dé hién thi.

Ready 4 q 3/ ¥~ b DO 0 63.06% m

stat B E € \J





c. Thanh ®Þnh d¹ng Formatting
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Cac thanh cong cu

Thanh Standard (noi chita cdc biéu tuong mdy in, ghi,
sao chéplién keét, bng....)

T BY R Y I L =R T Y
Thanh Formating (Noi chifa cdc biéu tugng Phong chit, mau chi,
kiéu chi, ¢d chi....).

co-szus[EES A A | oo tense )
Thanh Menu (chifa céc menu chon 1énh)
) e £t vew Iwert Famat Iook Sideshow Wndow Heb
Thanh Drawing : Chta céc niit cong cu dé v& hinh.

oun - [] Aoses \ N\ OO A G @A D2 A ]

Néu cdc thanh ndy ma mit ta 6 thé chon vio View->Toolbars-> Standard
(Formating) dé hién thi.

Ready 4 q 3/ ¥~ b DO 0 63.06% m

stat B E € \J





d. Thanh c«ng cô vÏ Drawing
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Cac thanh cong cu

Thanh Standard (noi chita cdc biéu tuong mdy in, ghi,
sao chéplién keét, bng....)

T BY R Y I L =R T Y
Thanh Formating (Noi chifa cdc biéu tugng Phong chit, mau chi,
kiéu chi, ¢d chi....).

co-szus[EES A A | oo tense )
Thanh Menu (chifa céc menu chon 1énh)
) e £t vew Iwert Famat Iook Sideshow Wndow Heb
Thanh Drawing : Chta céc niit cong cu dé v& hinh.

oun - [] Aoses \ N\ OO A G @A D2 A ]

Néu cdc thanh ndy ma mit ta 6 thé chon vio View->Toolbars-> Standard
(Formating) dé hién thi.

Ready 4 q 3/ ¥~ b DO 0 63.06% m

stat B E € \J





* Chó ý
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Cac thanh cong cu

Thanh Standard (noi chita cdc biéu tuong mdy in, ghi,
sao chéplién keét, bng....)

T BY R Y I L =R T Y
Thanh Formating (Noi chifa cdc biéu tugng Phong chit, mau chi,
kiéu chi, ¢d chi....).

co-szus[EES A A | oo tense )
Thanh Menu (chifa céc menu chon 1énh)
) e £t vew Iwert Famat Iook Sideshow Wndow Heb
Thanh Drawing : Chta céc niit cong cu dé v& hinh.

oun - [] Aoses \ N\ OO A G @A D2 A ]

Néu cdc thanh ndy ma mit ta 6 thé chon vio View->Toolbars-> Standard
(Formating) dé hién thi.

Ready 4 q 3/ ¥~ b DO 0 63.06% m

stat B E € \J





Bµi 2: C¸c thao t¸c víi  File vµ Slide
1. Më file míi
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- Nhain t6 hgp phim (Ctrl +0)

- Hogc chon File -> New

- Hofc nhdy chuot vio ; Trén thanh cong cu chudn
Ghi file:

- File -> Save (Nhin t6 hop phim Ctrl +S) Néu 1 file méi

hop thogi Save As xuat hién phai dat tén file trong khung:
File name > chon noi ghi & chit Save in -> nhip save két
thiic viec ghi.

Ready |4 q s/ ¥ D> Dl O O 0% v m

stan. o€ @ % [





2. Ghi file
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- Nhain t6 hgp phim (Ctrl +0)

- Hogc chon File -> New

- Hofc nhdy chuot vio ; Trén thanh cong cu chudn
Ghi file:

- File -> Save (Nhin t6 hop phim Ctrl +S) Néu 1 file méi

hop thogi Save As xuat hién phai dat tén file trong khung:
File name > chon noi ghi & chit Save in -> nhip save két
thiic viec ghi.

Ready |4 q s/ ¥ D> Dl O O 0% v m

stan. o€ @ % [





3. §ãng file


c1: --> File --> exit (Close)


c2: Nh¸y chuét vµo biÓu t­îng ch÷  X  mµu ®á ë gãc ph¶i phÝa trªn mµn h×nh

4. Më file ®· cã
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Thao tac v¢i file

Déng file: File -> Close
Mo mot file cii:
Chon mot trong 3 cdch sau:
- file -> Open
- Hodc nhan CTRL + O
- Nhép chuot vao biéu tuong [ trén thanh
cong chuén Standar
Hop thoai Open mo ra
Tim vi tri noi chi file (nhép chir look in tim
6 dia, thu muc chita file) -> Nhap chuot
chon tén file -> Nhép chuot vao [«

Reaty 4 q 73 YD D @ O B8m% v

stat &~z € [ % [m





* Khi b¹n ®· chän mét trong 3 c¸ch trªn th×: 
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Thao tac v¢i file

Déng file: File -> Close
Mo mot file cii:
Chon mot trong 3 cdch sau:
- file -> Open
- Hodc nhan CTRL + O
- Nhép chuot vao biéu tuong [ trén thanh
cong chuén Standar
Hop thoai Open mo ra
Tim vi tri noi chi file (nhép chir look in tim
6 dia, thu muc chita file) -> Nhap chuot
chon tén file -> Nhép chuot vao [«

Reaty 4 q 73 YD D @ O B8m% v
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5. C¸c thao t¸c víi Slide
a. T¹o mét slide míi
B¹n thùc hiÖn mét trong 3 c¸ch sau:

- Insert --> New Slide

- Ctrl + M

- Nh¸y chuét vµo biÓu t­îng New Slide trªn thanh c«ng cô Formating
b. Xo¸ Slide:

- Chän Slide cÇn xo¸ bÊm phÝm Delete

- BÊm chuét ph¶i ë Slide cÇn xo¸ chän Delete

c. Thay ®æi vÞ trÝ cña Slide
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Thao tac v¢i Slide

IV. Thao tic v6i Slide:

Tao m6i mot Slide:

- Insert -> New Slide
-Ctrl+ M

Xoi Slide: Chon Slide nhain phim Delete

Thay di vi trf Slide: Tir phia bén tréi clia man hinh thiét k€ chon tréi
chudt vao Slide cdn thay déi vi trf, gitt chuot ré t6i noi cin thiét réi
tha.

Xem 1 Slide : Khi thiét k& xong mot Slide ta c6 thé cho hién dé kiém tra
bing cch chon Slide cin hién -> nhin Shift + FS (Hogc nhp chudt
vao biéu tugng = trong cum [F= 3 phia dusi bén rdi man hinh thiet
k&)

4n mot Slide : Chon Slide - > Slide Show -> Hide

14 4 9/33 v b bl @ O 0% v m

PECELC % [





d. Xem mét Slide
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() Fle Edt Vew Language Doumert Tooks Advanced Window Help .| View PDFs onyour mobile devices

Thao tac v¢i Slide

IV. Thao tic v6i Slide:

Tao m6i mot Slide:

- Insert -> New Slide
-Ctrl+ M

Xoi Slide: Chon Slide nhain phim Delete

Thay di vi trf Slide: Tir phia bén tréi clia man hinh thiét k€ chon tréi
chudt vao Slide cdn thay déi vi trf, gitt chuot ré t6i noi cin thiét réi
tha.

Xem 1 Slide : Khi thiét k& xong mot Slide ta c6 thé cho hién dé kiém tra
bing cch chon Slide cin hién -> nhin Shift + FS (Hogc nhp chudt
vao biéu tugng = trong cum [F= 3 phia dusi bén rdi man hinh thiet
k&)

4n mot Slide : Chon Slide - > Slide Show -> Hide

14 4 9/33 v b bl @ O 0% v m

PECELC % [





e. Èn mét Slide
BÊm chuét ph¶i ë Slide ®ã  chän  Hide Slide
6. Tho¸t khái mµn h×nh tr×nh chiÕu
* Khi ®­a chuét xuèng gãc tr¸i phÝa d­íi mµn h×nh xuÊt hiÖn 


[image: image74.png]akl





Nót 1: Trë l¹i


Nót 2: HiÖu øng t« mµu, vÏ


Nót 3: KÕt thóc mµn h×nh tr×nh chiÕu


Nót 4: TiÕp theo

*  B¹n còng cã thÓ bÊm chuét ph¶i ë nÒn mµn h×nh tr×nh chiÕu vµ chän End Show
Bµi 3: §Þnh d¹ng Font ch÷ trong Slide
1. §Þnh d¹ng ch÷ trong Slide


Chñ yÕu sö dông thanh c«ng cô Formating
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- §Þnh d¹ng th«ng th­êng: Trªn thanh bao gåm c¸c nót lÖnh: Font ch÷, cì ch÷, ch÷ ®Ëm, ch÷  nghiªng, ch÷ g¹ch ch©n…

- §Þnh d¹ng c¸c khung chøa v¨n b¶n ta bÊm chuét vµo ®­êng viÒn khung khi xuÊt hiÖn 8 nót ®iÒu khiÓn vµ ta ®­a chuét vµo ®ã khi chuét biÕn thµnh mòi tªn 2 chiÒu th× ta bÊm chuét vµo ®ã ®iÒu chØnh phãng to hoÆc thu nhá lµ ®­îc.

2. §Þnh d¹ng Slide chñ
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cac_bunc_soan_Giao_An_de_t.. X

3.Dinh dang Slide chu:

¥ nghia: khi chen them 1 Slide m6i t lai méit cong dinh dang lai
phong chit,mau chit, mau nén cho slide:méi, vay dinh dang
Slide chii gitip chiing ta khi chén mot Slide méi thita ke’
duge nhimg thude tinh tir Slide chii ma ta da dinh dang ban

diu

Céch thic dinh dang Slide chi:
- Tai Slide ddu ta chon: View -> Master -> Slide Master
- Khi Slide Master xuat hién chon ta sit dung thanh cong cu
dinh dang (Formatting) dé dinh dang lai cho slide cha theo
¥ thich clia minh (Nén, phong chi, c3 ch, kiéu chit, mdu
chit,...)

Ready 14 4 1/3 L)
stat #Zc € ” [





3. §iÒu khiÓn c¸c Slide khi tr×nh chiÕu
[image: image77.png]oan_Giao_An_die_tu.pdf - Fo
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Foxit Toolbar, Simply Cooll

Giilp cdc thdy c6 thao tdc nhanh chdng khi trinh chiéu, dng thoi sit
cde biit ddnh ddiu dé chit § cho hoc sinh nhiing vin dé cdn nhdn manh
1. Dich chuyén tién I Slide: phdi chugt ->Next
2. Dich chuyén lui 1 Slide: phdi chugt -> Previos
3. Dich chuyén 16 mgt Slide: Go to Slide -> chon Slide cdn t6i
4.t dung biit danh ddit khi diéu khién:
Nhap phii -> Pointer Options Chon:
- Chon lai hinh déng ban ddu ciia chudt (Arrow)
- Chon biit nét ménh (Ballpoint Pen)
- Chon Bt nét to (Felt Tip Pen)
- Chon Bt t0 nhain manh (Highlighter)
- Chon Mau (Ink Color)
- Chon xo4 (Eraser) hinh du6i

Reaty

start
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4. Bµi tËp:
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Bai tap 1

Tao mt file PowerPoint mang tén bai bai gidng.
Yeu céu:
- Pinh dang Slide chii( Phong chit, mdu chit,...)
- Tyo tiép t6i thiéu 6 Slide (Soan noi dung cho slide)
- Thao téc véi Slide (chén méi, xof, di chuyén)
- Cho hi¢n Slide
- Piéu khién cdc Slide da tao

Ready W4 = v b b O 0w v
stat %€ (@ [ e «





Bµi 4: Thay ®æi nÒn, chÌn tranh vµo Slide

1. Thay ®æi nÒn cho c¸c Slide



B1: Chän Slide råi nh¸y chuét vµo Slide Show --> Animation Schemes…--> Design Templates råi b¹n chän  c¸c kiÓu nÒn  chung cho c¸c ®èi t­îng


B2: B¹n bÊm chuét ph¶i vµo Slide ®ã b¹n chän mét trong c¸c dßng lÖnh sau:


Apply to Master --> ®Æt vµo trang chñ


Apply to All Slide--> ®Æt tíi t©t c¶ c¸c Slide


Apply to Selected Slides--> ®Æt tíi 1 slide 

2. ChÌn c¸c ®èi t­îng

a. ChÌn tranh (¶nh) vµo Slide

[image: image79.png]oan_Giao_An_die_tu.pdf]
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Chén mét doi twong

1. Chen céc déi tuong
L Cheén tranh (anh) vao slide:

a. Chén vao mot Slide bat ky:

- Pua tro chuot Slide cdn chén.

- Chon Insert -> Picture -> From File... Xuat hién hop
thoai

- Tim dudng din dén thy muc c6 file tranh

- Chon tranh -> chon Insert.

- Dinh dang tranh, di chuyén t6i vi trf hop Iy.
(Chii : 6 thé copy tranh va dén thang vao Slide )

=5 T L S T T ar
stat %t @ @





b. ChÌn tranh vµo Slide theo mét khu«n mÉu ®Þnh s½n
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Chén theo khuén mau

b. Chén tranh vio Slide theo mét khuén méu dinh trude:
- Format -> Slide layout.
- Chon trong céc khung nhimg dinh dang thich hgp :
- Chon Apply to select Slide
- Chon vio biéu trgng chén tranh->chon tranh -> Ok

18l symyinUaI@yahes am-yr

ey [ 4 5/m ¥ b DO 6w m
stan. o€ @ @





3. ChÌn mét file Video, Audio
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4. ChÌn b¶ng
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1. Thém cot (hang):
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+ Nhap phai chudt chon : Insert columns (Insert Rows)

0t (hang) cdn xod
+ Nhép phéi chudt chon : Delete columns (Delete
Rows).
3. Pinh dang bang bing thanh cong cu Table and Borders.
Cho hién thanh nay Ién bing céch vao :
View -> ToolBars -> Table and Borders.
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5. ChÌn biÓu ®å
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Bµi 5: T¹o HiÖu øng
1. T¹o hiÖu øng cho c¸c ®èi t­îng trong Slide
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2. T¹o sù chuyÓn tiÕp cho Slide
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Bµi 6: T¹o sù liªn kÕt vµ vÏ h×nh
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2. T¹o liªn kÕt cho 1 ®èi t­îng
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11 Tao lién két cho déi twong

2.Tao lién két cho 1 doi tugng.

Budc 1: Chon doi tuong.

Budc 2: Nhdp chuot phdi vao doi twng chon Hyperlink...
Lam xudt hién hop thoai Insert Hyperlink

Budc 3: Chon ki€u lién két 1 mot trong cdc truomg hop sau:
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thu muc (tim dwong ddn t6i thu muc noi cé chi ook in).
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trén mdy.
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hién hanh.

Bude 4: Nhip OK

Chi : DE ga b lién két cho doi tugng, nhdp phai vao ddi tugng,

emove Hyperlink

oo soan Giao, An-rie_fu pd - Foxt Reader 2.3-
[q 4 0/%: ¥ D DI eac buse som Gao i c

Zce " [d % &)





II. VÏ h×nh chi Slide
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Vé hinh cho slide

1L V& hinh cho Slide:

Bue 1: Khoi dong thanh Drawing (View-> Toolbars-> Drawing).
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Bude 2: Chon cdc biéu tugng cin vé trén thanh Drawing hoac

nhip vio | Autoshages~ -> v vao slide.

Budée 3: Pinh danh hinh vé& nha cdc biéu tuong trén Drawing :
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Th­ môc ngÇm ®Þnh ®Ó b¹n ®Æt tªn file
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Gâ tªn file xong chän





Ghi l¹i tªn file råi tho¸t





Gâ tªn file ë ®©y





Tho¸t kh«ng ghi





BÊm vµo ®©y nÕu b¹n muèn t¾t m¸y
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NÕu b¹n kh«ng muèn t¾t m¸y th× bÊm vµo ®©y





Nh¸y vµo ®©y





Nh¸y vµo ®©y





 1





 9





 8





 7





 6





 5





Chän sè dßng  cÇn cã cña b¶ng





Chän sè cét cÇn cã cña b¶ng
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Sau ®ã chän sè cét, hoÆc dßng  cÇn chia nhá cÇn  chia nhá





 3





 2





 1





 3





Hình 24: Tạo bóng nền cho văn bản





In c¸c trang ch½n





�EMBED Unknown���
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Chia nhá « nh¸y vµo ®©y





Chén « nh¸y      vµo ®©y





Hình 21: Tạo hình ảnh kiểu nền mờ





Hình 20: Chèn ảnh vào trong văn bản
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BiÓu thøc logÝc 1
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Bá qua
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Vïng b¶ng tÝnh
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Tho¸t vµ ghi l¹i sù thay ®æi





Bá qua viÖc tho¸t





Hình 13: Tạo thụt đầu dòng và cách dòng











BiÓu thøc logÝc 2








Tho¸t kh«ng ghi l¹i sù thay ®æi
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In c¸c trang lÎ

















B«i ®en ®o¹n v¨n b¶n cÇn ®Þnh d¹ng råi nh¸y vµo ®©y





Khu vùc mµn h×nh trèng
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Kho¶ng c¸ch d·n dßng lµ 1.3
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Mật khẩu để thay đổi





Mật khẩu để mở
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Bàn phím tiêu chuẩn và vị trí các ngón tay
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�EMBED PBrush���





Quy ước, ý nghĩa của các phím với bộ gõ theo kiểu VNI
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Hộp Zoom


























Hình 3: Thanh trạng thái























Chế độ đánh chèn/đè





Cột





Dòng





Tổng số trang văn bản





Trang hiện thời





Thanh Menu






































Thanh thước dọc





Thanh trạng thái





Thanh cuốn ngang





Thanh Drawing





Thanh cuốn dọc





Thanh Formatting





Thanh thước ngang





Thanh Standard








Lên/xuống một trang màn hình
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